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Chapter 1: About this Guide
In This Chapter

• Related 
Publications

• Intended 
Audience

• Conventions

• Getting Help
Project Accounting for Government Contractors is a customized 
module of Microsoft’s Navision© product. Navision is a fully 
integrated, relational, financial database. It allows you to enter 
and maintain your general ledger, inventory, sales and 
receivables, purchases and payables, resources, and projects all in 
one place, one time, allowing you to have one software package 
instead of several.

Related Publications

The Project Accounting for Government Contractors 
documentation set consists of:

• This User’s Manual
• Standard Process Guide

Intended Audience

This guide is intended for basic computer users with a financial 
background. Pleasant Valley Business Solutions (PVBS) assumes 
that you have basic accounting knowledge. The information in 
this manual provides instructions on using the software to 
accomplish financial accounting tasks.

Conventions

The following conventions are used in this Manual.

Convention Description

Bold Actions you should take such as text to be typed 
exactly or items to click, or indicates you should 
type data exactly as shown.

Italics Arguments in which you must supply a value.

Not Used This term is used when a Navision feature is not 
applicable to Project Accounting for 
Government Contractors.
1-1



Getting Help

About this Guide
Getting Help

An on-line help system is available in the Navision interface by selecting Microsoft 
Business Solutions - Navision Help from the Help Menu. On-line help is also context 

sensitive. Clicking the What’s This? icon in the upper right corner of your 
application window and selecting an item in a window invokes help specific to that item.

If you need further assistance, please contact Technical support. Technical Support is 
accessible 9:00 am to 5:00 pm, EST. We’ll be better able to assist you if you have the 
following information:

• What is the problem? When did it happen? What were you trying to do when it 
happened? Can you recreate the problem? 

• What error message did you receive? Where did the error message appear? If 
possible, print screen or write down the message, verbatim, for discussion with the 
Tech Support Representative. You can capture error messages, forms, etc. from your 
screen by pressing Print Screen, opening Microsoft Word, or Microsoft Excel (use 
Excel for table / list captures), pressing Ctrl-V (Paste) then saving the file.

• What steps have you taken to resolve the problem? What happened?

You may call us at 703.218.5454. Fax (703.218.1617) or e-mail (support@pvbs.net) the 
above information along with any reports and error messages that relate to the issue. We 
respond by telephone or e-mail. 

When you call for technical support, you are routed through our voice mail system to the 
technical support message center. Under normal circumstances, you can expect a return 
call within four working hours. Please leave as detailed a message as possible. The more 
information we have prior to returning your call, the better prepared we are to address 
your issue.

Pleasant Valley Business Solutions’ URL is http://www.pvbs.net. You also can send 
correspondence to: 

Pleasant Valley Business Solutions
1895 Preston White Drive
Reston, VA 20191
1-2
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Chapter 2: Introduction
In This Chapter

• PVBS

• Microsoft 
Navision

• Project 
Accounting 
Module
The Project Accounting module of Microsoft’s Navision© 
product has been customized by PVBS to meet the needs of 
government contractors. This section generally describes 
Microsoft’s Navision product and specifically describes the 
Project Accounting module.

PVBS

PVBS is your Microsoft Solution Center for Microsoft Navision. 
We worked with your company to setup Microsoft Navision to 
your company’s needs, implement your system, and design your 
training program. PVBS is a certified reseller and consultant for 
Microsoft Navision. 

Microsoft Navision

Navision is a fully integrated, relational, financial database. It 
allows you to enter and maintain your general ledger, inventory, 
sales and receivables, purchases and payables, resources, and 
project all in one place, one time, allowing you to have one 
software package instead of several.

Microsoft Navision is a graphically based standard system for 
enterprise business solution. Because Navision is graphically 
based, all work on the screen is done in windows, many windows 
can be open at the same time, and you can use a mouse to choose, 
select, and execute various functions when working. Navision 
fulfills the requirements of an enterprise business solution by 
supplying tools for entering and managing information and 
always satisfying the current accounting laws.

Navision provides you the automated tools you need to monitor 
and manage indirect rates. You can track and report on an 
unlimited number of indirect rate hierarchies and cost pools. 
Effective rates can also be date sensitive. Microsoft Navision 
makes it easy to access the financial information you need to spot 
trends and gain insight into your business activities. You 
capitalize on your knowledge of how your business works by 
discovering opportunities, which otherwise might have been 
difficult to spot. 
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Project Accounting

Introduction
Project Accounting

Project Accounting for Government Contractors provides you the capability to manage 
various invoicing requirements and automate your billing process. This module allows 
your company to take control of growth, cash flow, operations, and profits. Whether you 
are billing fixed price, time & materials, or cost plus contracts, you can systematically 
generate invoices and Project Accounting for Government Contractors records these 
transactions including tracking your unbilled balances, retainage, and payment history. 

Setup and Activities

There are two types of functions performed in the Project Accounting module. These are 
setup tasks and activities. 

Setup tasks are typically done once or as new setup items are required. Setup windows 
include:

• Projects card
• Resources card
• Labor Category list
• Pricing Schedule
• Customer card
• Vendor card
• Logistics and Planning Items
• Web Time & Expense Web Projects ,Web Users, and Team
• All windows under Setup

Activities are performed often and become part of your planned work tasks. These 
include:

• Time Journal 
• Project Journal 
• Order Processing
• Logistics and Planning
• Web Time and Expense Reports and Periodic Activities
• Reports
• Periodic Activities
2-2
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Chapter 3: Understanding the User Interface
In This Chapter

• Opening the 
Application

• Opening a 
Database

• Application 
Window

• Window Types

• Icons

• Command and 
Menu Buttons

• New Records

• Entering 
Information

• Editing 
Information

• Menu Bar 
Overview

• Objects

• Dimensions

• Filtering
Project Accounting for Government contractors is an embedded 
module in Navision. A full interface description can be found in 
the Navision documentation. Key items pertinent to the use of 
this module are outlined here. Navision and the Project 
Accounting for Government Contractors module use standard 
Microsoft Windows© navigation.

Opening the Application

Navision is a standard Windows application.

To open the application:

1. Double click the MSB-Navision SQL icon on your desktop.

The application opens and a login screen appears.

Note: You may open the application using other Windows standard 
techniques.

2. Enter your User ID and Password.

This information is supplied by your systems administrator. 
Passwords are case-sensitive. User IDs are not case-sensitive. 

You may change your password by selecting Security and then 
Password from the Tools Menu. This change applies to the entire 
application, not just the Project Accounting module. 

Note: Take care to remember your password as the system 
administrator no longer knows it once you have changed it.

Note: Navision supports both the single sign-on system offered by 
Windows 2000 and the unified login system offered by Windows 
NT. If you are using either of these operating systems, your 
system manager can grant you direct access to Navision. 
Therefore, your system may be set up so that no password is 
needed to open the database on a server.
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Opening a Company Database

Understanding the User Interface
3. Click the Project Accounting Module in the Main Menu.

The tree is populated with Project Accounting data.

Note: The location of the module in the main menu is modifiable. Your Project Accounting 
may be located differently than the one shown.

Opening a Company Database

If your database contains multiple companies, you must open the company’s database to 
see its information. If only one database exists, it is automatically opened.

To open a company database:

1. Select Company and then Open from the File Menu.

A window appears with a list of companies.

2. Select the desired company.

Project Accounting Module
3-2
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The Application Window
Understanding the User Interface
3. Click OK.

The selected company’s information is now displayed in the project module.

Note: If you cannot open a company, it is because a database must be selected 
(File>Database> Open) and then a company.

The Application Window

The Application Window is the main point of entry for Project Accounting for 
Government Contractors tasks.

Title Bar

The Title bar displays the company you are currently working in, the name of the 
program (Microsoft Navision), a minimize button, a maximize/restore button, and a 
close button.

Title BarMenu Bar

Toolbar

Tree

Main Menu

Status Bar

Display 
Area
3-3
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The Application Window

Understanding the User Interface
Menu Bar 

This standard Windows feature contains pull-down menus to select functions such as 
creating new companies, design tools, and help. Functions which cannot be used appear 
dimmed (gray).

For the purpose of this module, the actions performed via the Menu bar are to open a 
Company database. All other functions are performed via the tree. Menu Bar functions 
are described in detail in “Menu Bar Overview” on page 3-18.

Toolbar 

The Toolbar contains a row of iconic buttons to give quick access to frequently used 
functions such as editing, filtering, and locating data.

These icons may look different in Windows 2000.

Status Bar

Located at the bottom of the application window, the Status bar shows name and 
contents of active fields, work date, user ID, and whether a filter (FILTER) is set as well 
as if you are in insert (INS) and /or overwrite (OVR) mode.

What’s This? Help Icon

List Icon
Record Sorting

Sort

Filtering Options
3-4
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The Application Window
Understanding the User Interface
Main Menu

The Main menu contains a list of Navision modules and is located on the bottom left of 
the application window. When you select a module, all of its folders and windows are 
displayed in the tree. The Project Accounting Module is available in the Main menu.

Tree

The tree appears on the left side of the application window. After you select a module in 
the Main menu, the tree is populated with items related within the module. You navigate 
the tree by clicking the desired item. Each item clicked opens a window in the display 
area. Clicking the expansion symbol (+) opens a folder. Clicking the collapse symbol (-) 
closes a folder.

Right-clicking on a tree item provides general window navigation options. These 
options are not specific to the module.
3-5
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Window Types

Understanding the User Interface
Display Area

The display area is the area in which windows appear. You can open as many windows 
as you wish. The window on top is called the active window. You can enter information 
in this window, and it is affected by the functions you execute. You can recognize the 
active window because its title bar is a different color than that of the other open 
windows. You can make a window active by clicking on it. 

Window Types

It’s important to understand the two types of windows used in Microsoft Navision. 
There are Card windows and Tabular windows.

Card Windows

Card windows show only one record per window. Card windows have labeled tabs at the 
top to help organize the information. You may change tabs by clicking on any of the 
tabs. Information specific to that tab is displayed. Typically, there are several fields, 
many of which are available for data entry. Some fields may be editable and some fields 
may not. Also, many card windows have menu buttons and command buttons at the 
bottom, which give you even more related information and easy access to useful 
functions. 
3-6
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Window Types
Understanding the User Interface
Tabular Windows

Tabular windows show multiple records per window. These windows have rows and 
columns. 

If the tabular window has more fields than can display in the list view, you can use the 
scroll bar at the bottom of the window to move left and right to view them all.

On the left there is a vertical panel called the line selector. You can use it to select a line 
or can click anywhere in the line. The line is now highlighted. You can click multiple 
lines by clicking and dragging the cursor over multiple lines. Selected lines are 
highlighted. Release the cursor to stop selecting.

Tabular windows may also have buttons at the bottom of the window. As with card 
windows, some tabular windows are for data entry and some are informational only.

Changing your window layout

You may change how tabular windows display. This changed view is associated with 
your User ID and saved within the ZUP file on your computer. Therefore, when you 
change how a window displays other users in your company are not affected.

Note: Changes you make are overwritten if you receive an object to replace the one which you 
modified. For example, if you change the location of columns in a journal and 
subsequently get a modified journal from PVBS, the column changes you made are lost.

Changing Column Width

To change the width of a column, place the cursor on the vertical line separating the 
columns after the name of the column to be expanded. The cursor displays as a vertical 
line with an arrow through it. Hold the mouse button and drag the column separator to 
the desired width. Release the mouse button when you are satisfied with the width.
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Changing Row Height

You can change the height of all rows or the heading row. To change the height of the 
heading row, place the cursor in the line selector column on the line below the heading 
row. The cursor becomes a horizontal line with an arrow through it. Hold the mouse 
button and drag the row separator to the desired height. Release the mouse button when 
you are satisfied with the height.

To change the height of all of the rows, other than the heading row, simultaneously place 
the cursor in the line selector column on the line below the row to be changed. The 
cursor becomes a horizontal line with an arrow through it. Hold the mouse button and 
drag the row separator to the desired height. Release the mouse button when you are 
satisfied with the height.

Moving Columns

To move a column, first place the cursor in the heading area of the column you would 
like to move. Hold the mouse button down so that the cursor becomes a hand and drag 
the column to the spot where you want to place it. Release the mouse button.

Showing and Hiding Columns

In addition to changing column height, row height and moving columns around you are 
also able to select what fields (columns) display. You can either right click on the 
heading section of the tabular window or select View>Show Column from the menu bar 
to see a list of available columns. To display a field in your window, place a check in 
front of the field name. To remove a column, remove the check. You must click OK in 
order for the chnage to take effect.
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Understanding Icons

The following icons are used within windows. They are in addition to toolbar icons.

Command Buttons and Menu Buttons

At the bottom of many windows are buttons that can be used to access useful functions 
related to the information in that window. The buttons with a small downward triangle 
are Menu Buttons and the others are Command Buttons.

Menu buttons offer you a pull-down menu with related options.

Command buttons execute a command for you. Some examples are Print or Help.

Icon Name Description

lookup arrow Clicking this icon displays the list window for 
that field. The list window may have modifiable 
options.

pulldown Clicking this item displays a pulldown list of 
items for selection. Dragging to an item and 
releasing, selects the item. The item is then 
displayed in the field.

ellipsis Clicking this icon allows you to view the 
number series that has been established. 

pencil Clicking this items displays a window in which 
you may enter notes about the record.

list arrow Clicking the list arrow in the toolbar displays a 
complete listing of records related to that card.

mail Clicking this icon invokes the default e-mail 
client.
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Adding New Records in Card Windows

When a card window is invoked, the last record viewed is displayed. 

To create a new record:

1. Open the desired card.

The card appears in the display area with the last record displayed open.

2. Place your cursor in the No. field and Press F3.

The card is repopulated with blank fields.

3. Enter the desired information.
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Modifying Records in Card Windows

When a card window is invoked, the last record viewed is displayed. You need to locate 
the desired record and then modify it.

To modify an existing record:

1. Open the desired card.

The card appears in the display area.
2. Click the List arrow icon in the toolbar.

A new window is invoked.

3. Select the desired item from the table.

4. Click OK.

The card is repopulated with the desired record.

5. Modify the desired information.

Note: You may also scroll through records using the record sorting arrows in the toolbar.

Entering Information

When entering information into fields, Microsoft Navision provides the format for the 
type of information you are entering. For example, a date field can only accept date 
parameters, a number field only accepts numbers, and a text field accepts everything.

Entering a Date

Microsoft Navision is very flexible in how you enter dates. The following are valid 
entries in a date field:

Data Description

W The work date you entered under Tools

T Today’s system date

C Closing date

# Number of the day in the current work month

Month-day-year 122502, 12 25 02, 12-25-02, 12/25/02 

weekday-weeknumber-year Fr5202, fr 52 02, fr-52-02, fr/52/02
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You may also enter abbreviations for the weekday and Microsoft Navision enters the 
date for that weekday based on your Work Date:

The Microsoft Navision week starts on Monday. The starting day for your week may be 
changed (or already configured) in Setup>Resources Setup. See “Resources Setup” on 
page 25-9.

PVBS recommends that you enter as few numbers as possible when entering dates. 
Microsoft Navision is set to accept dates through the next millennium. Microsoft 
Navision uses the year of your Work Date if you just enter the day and month. So, if 
your Work Date is 12/25/02 and you enter 1225, the date is set to 12/25/02.Microsoft 
Navision uses the month and year of your Work Date if you just enter the day. So, when 
your Work Date is 12/05/02 if you enter a day of 25, the date is set to 12/25/02. 

Navision supports the default Window date range of 1930 to 2029. Therefore, when you 
enter the year portion of a date with two digits, it is interpreted as 19xx if the number is 
between 30 and 99 and 20xx if the number is between 00 and 29.

Check Boxes and Option Buttons

Click on these boxes and a check mark or a black dot is placed in that field turning the 
option on.

Entering a Number or Amount

If a field accepts only numbers, enter the numbers without commas but with decimals. 
Numbers are always right justified on the screen and on printed material. Use a period as 
a decimal sign. All decimal number fields have a built-in mathematical function; you 
can enter calculations such as 13.50 * 2 - 12. The four basic mathematics operators are + 
(plus), - (minus), * (multiply), and / (divide).

Data Description

m Monday

tu Tuesday

we Wednesday

th Thursday

f Friday

sa Saturday

su Sunday
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Entering Codes 

A code is used to identify a record such as a Vendor No. or Customer No. Codes are also 
values that are used for the sorting of information on the screen and in reports. You can 
use numbers and letters for identification codes. If you use pure numbers as the Codes 
for a table, all Codes in the table should be pure numbers. If you use alphanumeric fields 
you can also use pure alpha codes in the same table. By using this format, filtering is 
easier. 

If you are entering information and need to find a code, go to the code field and click on 
the lookup icon. This gives you a list of available codes. It is best not to use special 
characters, such as the & sign, in codes because sometimes these characters are used in 
filtering Microsoft Navision information. You may use a dash (-) but avoid all other 
non-alphanumeric characters. 

When entering Codes from a related table containing alphanumeric or pure alpha codes, 
you only need to enter the characters that make this Code unique in the table. For 
example, to enter a Salesperson on a Customer Card and the table contained the 
following:

you would just need to enter SA for SAM or SU for Susan. When entering into Code 
type fields, Microsoft Navision changes all lowercase characters to uppercase.

Editing Information

Editing Fields

If a field is editable, you may highlight the text (or numerics) in the field and enter new 
text or you may add text to the field. Editable fields may require manual entry, pull-
down selection, or selection from list windows.

Inserting and Deleting Rows

To insert or delete a line in a tabular window, right-click and select the desired action. 
You may also use the F3 for insert and F4 for delete.

Posted Entries

You cannot change important information in posted entries. Only information such as 
due date, payment discount date, possible payment discount, applies-to ID, and whether 
the entry is pending approval can be changed. In order to make a change to these fields, 

Code Description

SAM Sam Jones

SUSAN Susan Smith
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you must click the field twice or press F2 to begin the edit. This protective editing 
function that only applies to these fields is called “inline editing.”

Copy and Paste

You can copy entire lines using the Copy and Paste functions, using the following 
procedure.

1. Select what you want to copy, right-click and select the desired function: from the menu.

2. Move to the spot on the empty line or card where you want to insert the copied line.

3. Right-click and select the desired function from the menu.

You can use this process to copy data from within Navision to a spreadsheet program 
such as Microsoft Excel. For security reasons, you cannot copy from Excel into 
Navision.

You may also use this process to create new cards in Navision from existing cards. 
Navision prompts you to change the Code field to be unique before you leave the card.

Filtering

Filters are used to limit the scope of the information that appears on a screen or report. 
They give you the ability to see only the information you want. You may select between 
Field, Table, and Flow filters.

When you set any of the three filter types, FILTER is shown at the bottom of the 
application window in the Status Bar. FILTER also displays when the system has set a 
filter internally. For example, when you view the Ledger Entries of a Customer, the 
system sets a Field Filter on the Customer No. field in the Customer Ledger Entry table.

If you are not completely sure which filter you need to use to see the desired information 
in a window, you can have the filter window opened simultaneously with the data 
window, then switch filters until the desired contents of the data window appear. For this 
purpose you can click on the Apply button instead of OK in the filter window. By 
clicking Apply you can test one filter after another and then click OK after finding the 
filter you want to use.

Field Filter

Field Filters apply to one field at a time in a table. Field Filters do not affect calculated 
fields, but they do limit the amount of information displayed. When you select a field 
and press F7 or select View>Field Filter, the program displays a Field Filter window. 
You can then enter the filtering information. 
3-14

User’s Manual



Filtering
Understanding the User Interface
Table Filter   

Table Filters enable you to combine multiple Field Filters. By accessing Table Filter you 
can filter by more than one field in a table at a time or view the filters you have set using 
Field Filter. For example, you can filter on multiple fields at once such as zip code and 
payment terms. Or, you could use Table Filter to view Vendors from a specific zip code 
and with balances above a certain amount. 

Most request forms offer several Table Filters to use while printing reports or batch jobs.   
Table Filter is different from Flow Filter in that it can be used to limit data on multiple 
fields in the system. If you are using multiple filters in the window you can use Ctrl F7 
or click on to see a list of each filter and edit them from this screen.

Both Field Filters and Table Filters are released by the Show All function which is 
accessed by View>Show All.

Flow Filters 

Flow Filters limit the contents of the fields that display amounts or quantities that 
Microsoft Navision calculates from entries in other tables. It does this by making a 
selection of the entries included in the calculations. The filter should be entered in the 
table where the calculated field appears and not in the table where the figures come 
from. Filters can be set in fields whose names end with the word Filter, such as Date 
Filter or Budget Filter. For example, if you want to see transactions for a particular 
department, you would use the Flow Filter feature to limit the function to the 
department. If you want to make entries to the budget for a particular department, you 
would use the Flow Filter feature. If you want to see how a promotion went, you would 
use the Flow Filter for a range of dates. 

Flow Filters may be used for a range of dates, departments, projects, budgets, and 
business units. Flow Filters are not released by the Show All function. You must access 
the Flow Filter on the same screen where you set the filter, blank the Filter column, and 
click on OK.

Filtering on Reports

In addition to allowing you to analyze data online, filters are also useful in selecting data 
to print on reports. When you select a report to print, a request form displays.

The Sort button in the lower right portion of the window can be used to select how you 
would like the data displayed on the report. If you wish to change the sort order, be sure 
to do so before setting any filters.

Each tab represents a table that is used to provide information for the report. On each 
tab, you can use the assist button in the Field column to select fields that are not 
displayed. On the same line as the selected fields, you can indicate filters to apply. 
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The Options tab is used to make general decisions about how to print the report. Some 
examples of this would be the option to print in detail or summary and whether company 
information (address, etc.) should print on the report.

SQL and Filtering Reports

It is important to understand how consistency of data may affect reports generated in 
Microsoft Navision on SQL. The SQL Server Option allows many users to interact with 
Navision simultaneously. This means that a wide variety of transactions can be carried 
out at any time. Although the data displayed by Navision is up-to-date, it is not 
necessarily completely consistent. For example, an incomplete transaction may cause 
inconsistencies to occur between the debit and credit in an account.

The only way to ensure the consistency of the data on which you base your reports 
would be to design the reports so that they lock the relevant tables or records. This 
prevents other users from inserting, deleting or modifying these records or tables while 
the report is being generated. However, this is not the default setting, and it is not a 
suitable method for designing reports.

Therefore, two procedures may be followed to ensure the consistency of the data used 
when generating reports with the SQL Server Option for Microsoft Navision:

• create batch jobs that generate your reports at night or at another time when the 
system is not being updated.

• set a filter in the report that places a date limit on the data used in the report so that it 
does not incorporate the day’s transactions. You could also limit the report to a 
department or branch that is not currently updating the system.

Various ways to enter filters are outlined on the following pages.

Filter Expressions

The table lists filter expressions:

Meaning Sample Expression Record Content Displayed

Equal to 377 377

Interval 1100..2100 1100 through 2100

..2500 Up to and including 2500

P8.. Information for accounting Period 8 and thereafter

Either/or 1200|1300 Those with 1200 or 1300. If there is a record with each 
number, both are displayed.

And <2000&>1000 Numbers that are less than 2000 and greater than 1000. 
(The & sign cannot be used by itself with numbers 
because records cannot contain two numbers.)

Different from 
(not equal to)

<>0

<>1000&<>2000

All numbers except 0

All numbers that are not 1000 and not 2000

Greater than >1200 Numbers greater than 1200
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Expressions can also be combined, as in the examples below:

Understanding Dimensions

Dimensions are used within Microsoft Navision to enable you to set parameters by 
which you slice and dice your information. Dimensions are data that you can add to an 
entry so that Navision can group entries with similar characteristics and easily retrieve 
these groups for analysis purposes.

PVBS creates Dimensions for you. The three main Dimensions are:

• Project
• Department
• Task

Project and Department are global Dimensions.

Greater than or 
equal to

>=1200 Numbers greater than or equal to 1200

Less than <1200 Numbers less than 1200

Less than or 
equal to

<=1200 Numbers less than or equal to 1200

An unspecified 
number of 
unknown 
characters (may 
be none)

*Co* Textual matter than contains *co* such as uncooperative, 
company, etc.

Co* Textual matter than begins with co* such as coordinate, 
company, etc.

*co Textual matter than ends with *co such as Debtco

One unknown 
character

Hans?n Textual matter than contains the specified letters, and one 
unspecified, such as Hanson or Hansen.

Meaning Sample Expression Record Content Displayed

Expression Description

5999|8100.. 8490 Include any records with the number 5999 or a number from the interval 
8100 through 8490

..1299|1400.. Include records with a number less than or equal to 1299 or a number 
equal to 1400 or greater - that is, all numbers except 1300 through 1399

>50&<100 Include records with numbers that are greater than 50 and less than 100 - 
that is, numbers 51 through 99

*C*&*D* Texts containing both C and D

@*co?* Texts containing co., CO., Co., cot, cope, incorporated.... (CO, cO, co or 
Co must be present, followed by at least one character, but there can be 
an indefinite number of characters before and after these, and case is 
unimportant).
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Understanding Objects

There are five types of objects in Navision. All of these objects can be changed based 
upon the needs of your company and your company’s workflow. Understanding the 
objects and how they work together helps you to understand and make the most use of 
Navision to manage your business. These objects are briefly reviewed below.

From the Menu Bar, choose Tools and then Object Designer. This window displays a list 
of all available objects.

You can view all of the objects, or you can choose to view only one type of object at a 
time. The five types of objects (as listed down the left side of the Object Designer 
window) and a basic definition of each are as follows.

Menu Bar Overview

The Menu Bar includes the following pull-down menus which are generally used in 
Navision:

• File
• Edit
• View
• Tools
• Window
• Help

Each menu can be accessed by clicking with the mouse or by hitting the Alt key 
simultaneously with the first letter that is underlined. For example, Alt + F accesses the 
File menu. Just pressing the underlined letter can then access the items listed on the pull-

Object Description

Table A place to store data. It consists of fields and each field holds a specific piece 
of information.   In a table, each line is a record; each record is made up of 
fields and each field holds one piece of information.

Form Displays information on the screen and gives access for editing, deleting and 
adding data in either a card or tabular form. The card form displays table data 
one record at a time, as you move from field to field you can change the data. 
The tabular form displays a list of several records at one time.

Report A print out (hard copy) of data. When you run a report, you may limit the 
information displayed by setting filters at the Request Filter Form. Reports 
can print in summary or detail and may be designed to print selected fields 
from individual records. A Document is a report that prints one transaction at 
a time. Reports are generally used internally by management and Documents 
are normally sent outside your company to Vendors, Customers or Tax 
Reporting Authorities.

Dataport  A method of importing or exporting information in and/or out of Navision.

Codeunit  A function that performs a process, such as posting or creating orders.
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down menus. Many of the items in the pull-down menus can also be accessed by using 
ShortCut keys. Shortcut keys are described in“Shortcut Keys” on page A-1.

Some of the options listed on the pull-down menus change or become inactive (shaded-
out) depending on what Microsoft Navision functional area you are currently working 
in. 

File Menu

Most of these functions are related to starting, closing and maintaining the databases and 
companies used in Microsoft Navision.

Menu Item Description

Close (Esc) Close the active window.

Save as HTML when a report is previewed to the screen, it may be saved as an HTML file. This file 
may then be opened in Excel and ‘What If’ analysis can be run on it. 

The file is imported as values; any formulas therefore have to be input into Excel.

Database (Alt-
F, b)

Create a New database, Open an existing database, Test a database (this must be done 
at least monthly), Expand a database size, Delete a database, Close a database, and 
Information about database size, connections and active sessions as well as a tables 
list that shows size and optimization. The functions in this program such as creating 
and deleting should only be done by the system administrator. The Database Used 
should never exceed 85% of the Database Size, and the Database Size should never 
(on a normal basis) exceed 85% of the Licensed Size. Microsoft Navision needs the 
last 15% of opened space to process activity and perform large tasks like Backup and 
Restore. If you are using the SQL Server Option for Microsoft Navision, you have 
available Altering databases. You may use this function to change the database 
properties whenever you think that it is necessary.

Company (Ctrl-
O)

Start a New company, Open an existing company, Rename a company, Delete a 
company, and Close a company. The functions in this menu other than open and 
close should only be done by the system administrator.

Page Setup, 
Print Preview, 
and Print 

Functions relating to printing documents and reports (Print and Preview are toolbar 
icons). These options become active when a document or report has been selected for 
printing and the Request Form is displayed.

Page Setup 
(Alt-F, g)

You may reset the margins on a report here, if desired. Generally, the margins are 
reset as a property of the report. We normally set all the margins on your checks and 
other documents where needed to 0.

Print Setup 
(Alt-F, u)

This is used to have a report print to a different printer than your default printer. Like 
Page Setup this must be changed when the request form of the report appears and 
then the report / document must actually be printed or previewed after setting the 
printer. From then on the report always defaults to that printer from your workstation 
until changes are made.

Send The Report by e-mail option enables you to send e-mail messages out of Navision. 
For example, you may create a Purchase Order, select to Print it and then Preview. 
With the document displayed on the screen, go to File, Send, Report by e-mail and a 
window opens up from which you may select the appropriate address to e-mail the 
document to. This function depends on having MAPI compliant e-mail. The file is 
sent in HTML format and may be viewed with a browser, and then printed.
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Edit

Includes several editing features for data entry into and between different Microsoft 
Navision windows.

Link by e-mail To use this option, first open the form or report you want to send a link for. With the 
document displayed on the screen, go to File, Send, Link by e-mail. Your e-mail 
opens a new message; a link is pasted to the Attach field from which the recipient can 
then access by double–clicking the link. 

Shortcut to 
Desktop

Shortcut to Desktop enables you to create a shortcut on your desktop to a form or 
report in Navision. 

1, 2, 3 List of recently opened companies; type the number or click on the list to re-open a 
company.

Exit (Alt-F, x) Exit Microsoft Navision program.

Menu Item Description

Menu Item Description

Undo (Ctrl-Z) To “undo” an editing error, such as deleting the contents of a field, but 
undo preceding action only (toolbar icon). This function is of limited use 
in Microsoft Navision because once we have left a field, we have written 
to the database.

Cut (Ctrl-X), Copy (Ctrl-C), 
and Paste (Ctrl-V)

 Standard Windows editing options for moving and removing 
information (toolbar icons). We can use these functions within Microsoft 
Navision or between Microsoft Navision and Microsoft Office products.

Clear (Del) This function removes only what is selected in the active window. This 
could be part of a field, an entire field, multiple fields, multiple lines or 
all lines. 

Copy Link This allows you to create a link to a form or a report. The form must be 
the active form in Navision. Click Edit, Copy Link. Navision places the 
link on the clipboard – you then paste the link using Edit, Paste.

Copy Previous (F8) To copy into a field the exact contents of the field above.

Insert New (F3) and Delete 
(F4)

To insert or delete records and fields 

Select (Alt-E, S) Used to select a single record in a table. This highlights the line you are 
on in blue and is the same function as clicking the mouse in the left-hand 
margin. You can also select multiple consecutive lines by holding down 
the Shift key and using the Down Arrow key simultaneously. In addition, 
you can select nonconsecutive lines. Click the first line and then using 
the Control key and click the line selector of the additional lines you 
want to select. 

Select All (Ctrl-A) Used to select all the visible records in a table / list. This respects all 
filters set on the table. Clicking in the upper left hand corner of a tabular 
window can perform the same operation.

Select Object Used in Object Designer.
3-20

User’s Manual



Menu Bar Overview
Understanding the User Interface
View

Includes functions that affect what is visible in the active window.

Toggle Mark (Ctrl-F1) To selectively mark records in a list / journal. This places or removes a 
diamond mark in the left-hand margin. This is then used with View 
Marked Only (Alt-V, M) to show and perform functions on only those 
lines that are marked.

Find (Ctrl-F) and Replace 
(Ctrl-H) 

Used to locate and/or replace specific contents of fields (toolbar icon). 
The Title Bar displays the field you are searching in. The Find What 
field is where you enter the information you are searching for. You may 
use Match to select what part of the field the value you enter should be 
compared to; the choices for Beginning or Any Part are only appropriate 
when searching in fields that display text or codes. Microsoft Navision 
distinguishes between upper and lower case if you place a check in the 
Match Case field. Selecting Use the Best Key results in Navision 
resorting the table in the order that results in the fastest search; this is 
especially useful in large tables. When Find as you Type is selected, 
Navision begins searching for the text as you type in the value. Navision 
stops and display what it has found when it finds a value that fits the 
search string. If the record displayed is not the one you are looking for, 
you may use the Find First, Find Next and Find Previous buttons to 
locate the appropriate record. If you want to replace the value, use the 
Replace button to indicate the value to substitute.

Menu Item Description

Menu Item Description

Go To  Go to first, previous, next or last records (toolbar icons).First 
(Ctrl-Home), Last (Ctrl-End), Next (Page Down), Previous 
(Page Up)

Field Filter (F7), Table Filter (Ctrl-
F7) and Flow Filter (Shift-F7) 

Microsoft Navision’ functions to filter records in a window 
based on certain criteria.

Marked Only (Alt-V, M) To show only those records marked by the Toggle Mark (Ctrl-
F1) function in a window.

Show All (Alt-V, A) To release filters you have set and to show all records again.

Toolbar Choose whether the toolbar is displayed and in what manner. 
Some options are color, size, and “Teletypes” (cues).

Hide Column (Alt-V, H) and Show 
Column (Alt-V, u)

For use with windows with rows and columns (tabular windows) 
to choose which columns is visible. This same functionality can 
be achieved by right clicking on the heading portion of the 
tabular window.

Refresh This option is available if you are using the SQL Server Option 
for Microsoft Navision. You use this function to refresh the data 
that the active window contains. Navision then ensures that the 
newest data appears in the window.
3-21
User’s Manual



Menu Bar Overview

Understanding the User Interface
Sort 

To change the order data displays change the sort order of the table, such as customer 
number or entry number (toolbar icon). The sort is as follows – numbers only without 
blank spaces or special characters then letters only or numbers and letters combined. 
When numbers and letters are combined, the field contents are checked character by 
character from left to right. The sorting priority is as follows – blank spaces come before 
something, letters come before numbers, and numbers come before special characters.

These rules result in the following sorted list:

It is important to be familiar with sorting rules sot that filters can be entered correctly. 
For example, the filter A100...110 does not result in any data being found since the 
interval cannot exist. The result of an incorrectly used filter can be incorrect or even no 
information. 

To ensure that numbers are sorted correctly, you must use the following principles: 
always use a numerical series of a fixed length (100 to 999), never use a numerical series 
such as 1 to 999 in code or text fields, and never use a numerical series such as 001 to 
999 in code or text fields.

The SQL Server Option for Navision sorts numbers as if they were text as illustrated in 
the following table.

Order Reason

1 Numbers without blank spaces or special character come before letters or combinations of 
numbers and letters, and Navision counts in ascending order

A 1 This is a combination of letters and numbers. It comes before other such combinations 
because the blank space between A and 1 comes before anything else.

ABC

AB1

Letters come after blank spaces (so ABC comes after A 1 above) but before numbers in 
letter/number combinations. So ABC comes before AB1

A1 Numbers are sorted before letters, so A1 comes before AB.

D S B D comes after A, blank spaces come before something.

D1 Numbers are sorted before letters, so D1 comes before D S B.

D.S.B. Special characters come after numbers.

1A A number at the start of a combination of letters comes next to last in the sorting order.

+A1 Special characters come last in a sorting.

Numerical Sorting Text Sorting

1 1

2 10

3 100

4 2

10 3

100 4
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To avoid this problem, you should use a numerical series that has a fixed length by 
either specifying a numerical series that has a predefined number of digits and starts 
with a number other that zero or manually follow the numbering principles and use a 
fixed number of digits.

Tools 

Contains the major programming functions and setup options.

Menu Item Description

Work Date Allows each user to enter a date that the system uses when entering transactions 
that is different from the system or actual date. For example, you may have 
several transactions to enter that were dated 3/20/02. However, today's date is 3/
31/02. By changing the work date to 3/20/02, you won't have to manually enter a 
date. You can override the work date when entering transactions by typing t for 
today's date or entering a different date. The Work Date is also used to determine 
the default year and month Microsoft Navision uses when you enter either just the 
day of the month or the month and day. (See the Entering Information section).

Language Displays a table of the application languages. 

Object Designer 
(Shift-F12) and 
Designer (Ctrl-F12)

Allows the use of the Microsoft Navision C/SIDE application development 
system to modify the application and customize forms or reports. Special 
permission is required to use these functions.

Debugger Used by PVBS when they customize Microsoft Navision.

Client Monitor Used by PVBS to monitor the communication between server and clients in a 
network to ensure efficient communication.

Zoom (Ctrl-F8) Allows users with Super-user permissions, to see the contents of every field in the 
current record. This gives you the ability to see every field available in a table 
even when they are not displayed in the window.

Backup and Restore Allows backup of one company, all companies, application objects, or entire 
database. Backups can be performed at any time due to the unique feature within 
Microsoft Navision called Version Management. Before a backup, the system 
takes a picture of the version at the time of the request and then backs it up. This 
allows other users to continue processing in the program and means that backups 
do not have to be done after hours. A backup should be performed every day. If 
you need to restore a backup, use the Restore procedure to restore a backup made 
using the Microsoft Navision Backup program. We recommend you call PVBS 
Technical Support department for assistance. Microsoft Navision does not 
overwrite existing data therefore companies must be renamed or deleted prior to 
running the Restore function.

Security Used to enter users into the system with options of Roles, Database Logins, 
Window Logins and Passwords. Each user on the system should be given rights to 
access menus, windows, tables and functions in Microsoft Navision. Each user's 
name and password (if needed) is entered in this window to have access to the 
Companies set up in Microsoft Navision.The Password option allows you to 
change your password. You are prompted for your User ID and current Password. 
You can then enter your New Password which you must enter a second time. 
Next the Application Window is blank. Press Ctrl-O to Open a Company. The 
Login form reappears and you now enter your User Id and new Password. If you 
are using the SQL Server Option for Microsoft Navision, you also see the 
Synchronize function under Tools, Security. The synchronization process is the 
heart of the security system for SQL Server Option for Microsoft Navision.
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Window

Contains information related to windows that are currently open.

Help

Contains many Help options.

License Information Shows contents of the license file under which you are working including the 
license number, who owns it and, if there is a time limit, when the license expires. 
Your license file is named fin.flf. If you want to see all the functions in Navision – 
including those for which you have not purchased permission – you can use the 
license file cronus.flf. To change the license, select Tools, License Information 
and select the Change button, then browse to locate the license. 

Custom Controls this menu item provides a list of OCX controls registered in Windows. 

Options Contains the program setup options which include DBMS Cache (KB), Commit 
Cache, Object Cache (KB), Net Type, Status Bar, Close Forms on Esc, Marquee 
Full Selection. Your System Administrator is responsible for monitoring these 
options.

Menu Item Description

Menu Button Description

Close All (Alt-W, A)  Closes all open windows.

Arrange Icons To arrange the icons shown on lower border of the application window that 
appear when you minimize a window (double-click the icon to maximize 
again).

1, 2, 3 List of currently open windows.

Menu Item Description

Microsoft Navision Help Shows a table of contents available in Help system.

C/SIDE Reference 
Guide

Reference tool for programming.

What’s That? (Shift-F1) Transforms the cursor to a Help cursor that can retrieve Help for 
everything on the screen (Toolbar icon).

Overview of F Keys 
(Alt-F1)

Displays an overview of the function keys in the program. The 
functions displayed are context sensitive. A complete listing is in the 
section Short Cut Keys.

About Microsoft 
Navision 

Displays product information, including the version number of the 
program
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Chapter 4: Projects Card
In This Chapter

• Creating New 
Projects

• Modifying 
projects

• General tab

• Posting tab

• Contract tab

• Project button

• Setup button
Projects are the center of Project Accounting for Government 
Contractors. You use the Project card to setup projects. You can 
also set up project related information like contracting office and 
paying office on the card. In addition, you may view project 
statistics and ledger entries from the Project card.

Creating New Project Records

You can create Time and Materials, Cost Plus Fixed Fee (CPFF), 
or Firm Fixed Price projects. The process for creating projects is 
the same, but the options selected may differ depending on which 
type of project you are creating.

To create a new Project record:

1. Click the Projects card in the tree.

The Project card appears in the display area.
2. Place your cursor in the No. field and Press F3.

The card is repopulated with blank fields.

3. Click the General tab.

The card is repopulated with General tab information.

Note: When creating a new record, the General tab appears on top.

4. Type the Project Number.

You can enter notes by clicking the pencil icon.

To view all projects set up in the system press the list key located 
on the toolbar. 

5. Enter the Project Description. 

Type the description of the Project. The maximum number of 
characters is 50. 

6. Click the lookup arrow to enter the client number.

A table window appears.

If this is a new client, click the card from the Customer button in 
the lookup window. See “Customer Card Setup” on page 8-1 for 
entering new customer information.

7. Select the desired client number and click OK.

8. Click anywhere in the name field and the remaining client 
information is populated.

9. Enter information in the Project area.
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The information entered in this area depends on the type of project your creating. You 
can set up a Time and Materials (T&M), Cost Plus Fixed Fee (CPFF), or Firm Fixed 
Price project.

Check the WBS Mandatory box for all project types. This is required.

Select the desired project type from the Type pull-down.
10. Enter information in the Posting tab as outlined in “Posting Tab” on page 4-4.

The information entered in this area depends on the type of project your creating. You 
can set up a Time and Materials (T&M), Cost Plus Fixed Fee (CPFF), or Firm Fixed 
Price project.

The Default Posting group must match the Posting Group chosen in the General tab. If 
you have multiple contract types, you may use the override options to declare additional 
posting groups.

11. Enter remaining information in the Contract tab as outlined in “Contract Tab” on page 4-
6.

12. Enter detail in WBS which is accessible from the Setup Button. 

See “WBS” on page 4-8.

13. Open the Task Order Detail Card accessible from the Setup Button. 

See “Task Order Detail” on page 4-10.

14. Select the task you created in WBS Setup and enter task order details.

Upon completion of Task Order Detail setup, many of the Contract tab fields are 
populated.

15. Depending on what type of project you are creating, select the options in the Setup 
button.

For T&M, use T&M Resource Prices (see “Setup Menu Button” on page 4-8).

For CPFF, use Cost Plus Budgeted Rates (see “Setup Menu Button” on page 4-8).

For FFP, use Fixed Price Billing Schedule (see “Setup Menu Button” on page 4-8).
16. Add the project to Web Projects by selecting ADD/View Web Project from the Project 

menu button.

17. As desired, set the Resource Labor category specifically for this project.

This is identical to the Labor Category list. See “Labor Category Setup” on page 6-1

18. As desired, set the G/L Budget. 

G/L Budget is described in “G/L Budgets” on page 4-11.

19. As desired, view information in the Project menu button. See “Project Menu Button” on 
page 4-7.
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Modifying Existing Project Records

You can modify existing project records.

Note: Once the order status is changed to completed, no other changes can be made to the 
project. If you wish to inactivate the project, check Inactive on the Posting tab.

To modify Project records:

1. Click the Projects card in the tree.

The Project card appears in the display area.

2. Select the desired Project Number by clicking the toolbar List icon while in the No. field.

The Projects list window appears. 
3. Select the desired project row and click OK.

4. Make changes as desired for each tab and menu button option as described in this 
chapter.

General Tab

The General tab allows you to enter basic information about the project. 

To enter information in the General tab:

1. Click the Projects card in the tree.

The Project card appears in the display area.
2. Click the General tab.

The card is repopulated with General tab information.

3. Enter the project No.
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You can add a new record as described in “Adding New Records in Card Windows” on 
page 3-10 or you may modify records as described in “Modifying Records in Card 
Windows” on page 3-11. You may also enter the number manually. You can enter notes 
by clicking the pencil icon.

4. Type the description of the Project. 

The maximum number of characters is 50. 
5. Click the lookup arrow to enter the client number.

A table window appears.

6. Select the desired client number and click OK.

7. Click anywhere in the name field and the remaining client information is populated.

8. View and select the Contracting Office using the lookup icon. 

9. Select the Office number via the lookup icon and the name appears.

10. View and select existing Paying Office via the lookup icon. 

11. Select the Office number via lookup and the name appears.

12. Enter Project Information.

Select the project status. Order is the default status. Update the status to Completed once 
the project has finished. Once status has been changed to Completed, no other changes 
can be made.

Program Manager No. allows you to select the project manager for this project. The 
manager name automatically updates with the Manager No. selection.

Select the Type of Project from the pull-down.

Note: The selection of the contract type determines how the system generates revenue and 
billings.

Check the WBS Mandatory box to require WBS for the project. This is required for all 
projects.

Enter starting and ending project dates.
13. Enter Contract Information.

Enter the primary and other contract numbers.

Posting Tab

The Posting tab allows you to enter information related to posting the project.

To enter Posting Information:

1. Click the Projects card in the tree.

The Project card appears in the display area.

2. Click the Posting tab
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The card is repopulated with Posting tab information.

3. Select None, Cost Plus Percent or Billing for FFP Recognition Calculation and enter the 
FFP Recognition Percent.

4. Enter Project Posting and Recognition Dates.

These fields automatically display the date when the batch process Post Project work in 
progress (WIP) status to G/L was started and the date when the batch process Post 
Project Recognition to G/L was started.

5. Check the Inactive box to block further posting to a project, if desired.

This field can be used if a project is temporarily on hold yet has the status Order. You 
can remove the blocked status by clicking the checked box again to remove the check 
mark.

6. Division Code and Department Code.

The Last Date Notified field displays the date of the most recent change of information 
on the Project card. Navision automatically updates this field.

7. Enter Project Posting Information. 

Here you can assign a Project Posting Group code to a project. Project posting groups 
determine which G/L accounts are posted when you run batch processes: Post WIP 
Value to G/L and Post Recognition to G/L. There are also two types of accounts in the 
general posting setup that determine which accounts are posted to the general ledger 
when posting project WIP and project revenue recognition. 

Note: This field MUST be populated for the system to post transactions.

8. Select the desired posting overrides for T&M, CPFF, or FFP.
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Contract Tab

The contract tab allows you to record the contract details about the project. You must 
enter data in the Task Order Detail window after entering data in the Contract tab. Data 
from Task Order Detail will populate most of the fields on this tab. See “Task Order 
Detail” on page 4-10.

To enter contract information:

1. Click the Projects card in the tree.

The Project card appears in the display area.

2. Click the Contract tab.

The card is repopulated with Contract tab information.

3. Lookup the Contract Amount and Funded Amount.

The Contract Amount shows the contract value from the Task Order Detail Card. Enter 
the contract value in the Task Order Detail Card as described in “Task Order Detail” on 
page 4-10.

Note: Task Order Detail MUST be set up first.

The Funded Amount shows the Funded Amount from the Task Order Detail window. 

4. Verify the type of project.

This selection is populated by your selection in the General tab.
5. Enter the Contract numbers.

Other Contract No. field is used when an additional contract number is required in such 
cases as a GSA contract number or in the case of a sub-contract of a prime contract 
number.

6. Enter client types.

Client types include Commercial, Federal Government, State Government, and Local 
Government.

Check sub-contractors if sub-contractors are allowed. The field is for informational use 
only.
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7. Depending on the contract type selected, remaining fields may differ. Enter the desired 
information.

For T&M, enter Fee information. If you are billing other direct cost (ODC), enter the fee 
Percentage. The percent should be entered as 10 not .10 for 10%. If there is a burden on 
ODC with indirect costs enter the percentage here. The percent should be entered as 10 
not .10 for 10%. Fees Not to Exceed the contract or funded amount are completed by 
checking the Contract box and entering the fee amount. Enter the Pricing Schedule 
Code. Click the lookup icon to invoke the pricing schedules window and select the 
desired schedule. See “Pricing Schedule Setup” on page 7-1.

For FFP, enter the witholding percent on project or labor. Enter the progress payment 
billing and rate and whether to bill ODCs.

For CPFF, enter the fee information, the witholding percent for project or labor, not to 
exceed parameters, and whether the billing rate is provisional or budgeted.

Project Menu Button

The Project menu button allows you to view related information to the project. 

To enter Project menu button information:

1. Click the Projects card in the tree.

The Project card appears in the display area.
2. Click the Project button.

A pull-down menu appears allowing you to select the desired function:

Menu option Description

List View all project numbers in the system.

Statistics Displays projects summary of details budgeted and realized like Invoiced Price for 
Resources or Miscellaneous, Excess Invoicing, Profits.

Comments Select comments to add comments to the Project card.

Dimensions The selection allows you to set default dimensions for project accounts. 

Ledger 
Entries

The Project Ledger Entries window allows you to view all the ledger entries for a 
project. Posting to projects always creates project ledger entries. The entries are either 
debits or credits depending on whether they increase your costs or represent sales to a 
customer. Entries in the project journal, sales credit memo, and purchase invoices 
create positive project ledger entries. Entries in a purchase credit memo or a sales 
invoice create negative project ledger entries. The window contains a line for each 
entry.

Add / View 
Web Projects

This function allows you to view projects in Web time and Expense. You can also 
synchronize projects with Web Time and expense from that module.
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Setup Menu Button

The Setup Menu Button allows you to setup items related to the project. It may be 
necessary to enter setup information before completing data entry into the tabs of the 
Projects window.

To enter Setup menu button information

1. Click the Projects card in the tree.

The Project card appears in the display area.

2. Click the Setup button.

A pull-down menu appears allowing you to select the desired function:.

WBS

This setup option is required for all projects and is available when the WBS Mandatory 
box has been checked on the General tab. The WBS defines different tasks associated 
with the contract.

To set up a WBS:

1. Click the Projects card in the tree.

The Project card appears in the display area.

2. Click the Setup button and select WBS.

Menu Option Description

WBS (Work Breakdown 
Structure)

This function is valid only if the “WBS Mandatory” box checked 
located on the General tab is checked. The WBS defines a different 
tasks associated with the contract. 

Task Order Detail Describes the details about the task. See “Task Order Detail” on 
page 4-10.

Resource Labor Category This feature allows you to map your resources (employees) to a 
specific labor category.

T&M Resource Prices Assigns the billing rate for a resource (employees) or sets maximum 
hours per month for a specific project. The system allows billing 
rates to change on a designated date. Put in the effective date of the 
change with the new billing rate.

Fixed Price Billing Schedule Schedule creates a recurring journal to generate fixed price invoices 
on a scheduled basis. See “Recurring Journals” on page 24-1 for 
more information.

Cost Plus Budgeted Rates Creates indirect rates for each Project by the cost pool sequence 
number. Enter the Project No. Sequence, Start Date, and Rate. 
Budgeted rates are used for project billing and costing purposes.

GL Budgets Budgets for each project are an option in Navision. This options is 
described below in “G/L Budgets” on page 4-11.
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The WBS window appears on top of the Project card.

The project number defaults to the current project number. 
3. Enter a WBS Separator.

This indicates what character is used to separate the levels. Normally this is a “-”. Once 
ledger entries are associated with the separator it cannot be changed. Optionally, it can 
also be a “.”.

4. Enter the Task Order Level.

This defines the billing level, the funding, and how the amount in excess is calculated for 
the project. The WBS level is the number of WBS separators plus one. For example, 01-
01-01, the WBS level is 3.

5. Insert, delete, and modify rows.

You can import the WBS structure from a tab delimited file, if desired, by selecting 
Import WBS Structure from the Function Menu button.

Note: You cannot change the task order level to a higher level than already specified.

Note: Once actual cost has been accumulated, it cannot be changed.

6. View budget entries by selecting Budget Entries from the Functions menu button.

Field Description

Clin Government funding number.

ACRN Government funding number.

Task Code Task order code. 

WBS Code The WBS code. 

Description Description.

Chargeable Check if it is chargeable.

Total Hours Number of hours.

Total Budgeted Amount Budgeted amount.
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Here you can setup budgets for individual tasks. Budgets can be set up by labor category 
or based on G/L account number. You can view budget entries by G/L account or labor 
category. You can specify the dates by budget entry for ODC and Indirect Costs.

Task Order Detail

The task order detail card defines the tasks associated with this project. This window is 
completed after entering information in the Contract tab. This window is required. 

To set up Task Order Detail:

1. Click the Projects card in the tree.

The Project card appears in the display area.

2. Click the Setup button and select Task Order Detail.

3. Click the Project button and select Card.

The Project Task Order card appears.

The card has the same fields as listed in the Task Order Detail table, accessed via the 
projects card Setup button, plus additional options. For instance, you can change the 
Type for just this task. 

4. Enter general information about the task in the General tab.

The Project number and task code are populated. You can enter the WBS code and 
modify the description. Enter the override client number and paying office, if desired. 

You can inactivate the task by clicking the check box. 

The project information must match the existing type of project.

Enter an additional contract number if desired.
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5. Enter information on the Task tab.

The project information must match the General tab, which also must match the project.

Fee information is entered for ODCs.

Enter amounts not to exceed, the billing rate, and amount allowed in excess of cost.

6. As desired, utilize additional options under the Projects button.

G/L Budgets

Budgets for each project are an option in Navision. A tailored budget in which every 
single resource and cost of goods sold is divided into the periods that you need is 
available.

Please see Navision G/L Manual for detailed information.

Note: You can make certain modifications to the budget as it pertains to this project. Actual G/
L setup is performed in the Financial Management module.

Option Description

WBS Invokes the WBS window as described in “WBS” on page 4-8.

Modification Detail View or enter changes to task order funding details.

Completion Percent View or change the project completion percentage.

Ledger Entries View Project ledger entries.
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Chapter 5: Resource Card Setup
In This Chapter

• Creating New 
Resources

• Modifying 
Resources

• General tab

• Invoicing tab

• Personal Data 
tab

• Resource 
button
The resources card allows you to setup human resources. 
Production and project planning can be based on the availability 
and capacity of resources. Resources can also be included in bills 
of materials, project planning, and project costing. 

Creating New Resource Records

You can create new resources.

To create a new Resource record:

1. Click the Resources card in the tree.

The Resource card appears in the display area.
2. Place your cursor in the No. field and Press F3.

The card is repopulated with blank fields.
3. Click the General tab.

The card is repopulated with General tab information. 

Note: When creating a new record, the General tab appears on top.

4. Type the Resource Number or press F3.

You can enter notes by clicking the pencil icon.

To view all resources set up in the system press the list key 
located on the toolbar. 

5. Enter remaining General tab information as described in “General 
tab” on page 5-2.

6. Click the Invoicing tab.

The card is repopulated with Invoicing tab information. 

7. Enter Invoicing tab information as described in “Invoicing Tab” on 
page 5-3.

8. Click the Personal Data tab.

The card is repopulated with Personal Data tab information. 

9. Enter Personal Data tab information as described in “Personal 
Data Tab” on page 5-4.

10. Click the Resources Button.

11. As desired, view information via the Resources menu button. See 
“Resource Menu Button” on page 5-5.
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Modifying Existing Resources Records

You can modify existing resources.

To modify Resource records:

1. Click the Resources card in the tree.

The Resource card appears in the display area.

2. Select the desired Resource Number by clicking the list icon while in the No. field.

The Resources list window appears. 
3. Select the desired resource’s row and click OK.

4. Make changes as desired for each tab and menu button option as described in this 
chapter.

General tab

The General tab allows you to enter basic information about your resources.

To enter information in the General tab:

1. Click the Resources card in the tree.

The Resource card appears in the display area.

2. Click the General tab.

The card is repopulated with general tab information.

You can add a new record as described in “Adding New Records in Card Windows” on 
page 3-10 or you may modify records as described in “Modifying Records in Card 
Windows” on page 3-11. You may also enter the number manually. You can enter notes 
by clicking the pencil icon.

3. Type the Name of the resource. 

The maximum number of characters is 30. 
4. Specify Person for the resources Type.

5. Enter the Base Unit of Measure.

This field is used to specify the units by which the resource is tracked. The base unit of 
measure should always be hours.
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6. Enter the Vendor Number.

Enter a vendor number for the employee. This number is used to pay expense reports 
using purchase invoices.

7. If the resource is a Sub Contractor, check the sub contractor box.

8. Assign the person to a Labor category. 

9. If desired, check Blocked to inactivate a resource record. 

Once the resource is blocked, the system does not allow you to do any kind of posting 
using this resource.

Note: The block is effective immediately. Make sure employees have received a final payment 
before blocking.

The Search Name field is automatically defaulted once you enter the Resource Name.

Last Date Modified is a system generated field, to show the last date the record was 
modified.

Invoicing Tab

The invoicing tab allows you to specify information about resource invoicing.

Note: Do not enter unit or direct cost on the invoicing tab.

To enter invoicing information:

1. Click the Resources card in the tree.

The Resource card appears in the display area.

2. Click the Invoicing tab.

The card is repopulated with Invoicing tab information.
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3. Enter posting Group information.

The Gen. Prod. Posting Group field is used to classify the resource for General posting 
purposes. When you sell a resource, Navision uses this field to match with the general 
business posting group. From this combination, Navision uses the General Posting setup 
table to determine what G/L accounts to affect. 

Note: Gen. Prod Posting Group is a mandatory field.

4. Enter the Division Code and Department Code.

Note: The remaining fields are not used.

Personal Data Tab

The Personal Data tab allows you to enter personal information about the resource.

To enter the resource’s personal data:

1. Click the Resources card in the tree.

The Resource card appears in the display area.

2. Click the Personal Data tab.

The card is repopulated with Personal tab information.

3. Enter the Job title and resource’s address.

4. Enter the Social Security Number.

5. Enter the resource’s Education and Contract Class.

6. Enter the date of employment.

7. If the resource is salaried, check the salaried box.

8. Enter ADP/PayChex File No.

This is the Employee number with the payroll processing company. This is a mandatory 
field if a payroll service is being used.

9. Enter the PayData Password.

Once a valid password is entered, pay rates are revealed and can be changed. If hourly, 
employee overtime rate must be entered. If shift worker, shift rates must be entered.
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Resource Menu Button

The resources menu button allows you to view additional related information.

To enter Resource menu button information:

1. Click the Resource card in the tree.

The Resource card appears in the display area.

2. Click the Resource button.

A pull-down menu appears allowing you to select the desired function:

Menu Item Description

List Select this to view a list of resources.

Statistics Select this option to view summary sales information.

Comments Select comments to add comments to the resource card. 

Dimensions This selection allows you to view default dimensions.

Ledger Entries This option allows you to view all postings for a resource record. This 
includes time postings and billings for a resource.

Extended text If the record needs to have more information in addition to the Name 
field, you can store extended text, which can be displayed on the sales 
invoice.

Picture If a picture of the employee is available, it is displayed. 

Units of measure Enter unit codes.

Service Zones Not used.

Skills Not used. 

Resource locations Not used.
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Chapter 6: Labor Category Setup
In This Chapter

• Category Menu 
Buttons

• Prices menu 
Button
You use the Labor Category Groups window to set up Labor 
Category groups. You can combine several resources in one 
Labor Category. All capacities and budgets of Labor Categories 
are accumulated from the individual resources. 

The window contains a line for each Labor Category. You can set 
up as many Labor Categories as you need.

To access the Labor Category list:

1. Click Labor Category in the tree.

The Labor Category list appears in the display area.

2. Insert, modify, or delete rows as desired.

Enter the labor category code and the name.
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Category Menu Buttons 

The Category menu button allows you to 

To enter Category menu button information:

1. Click Labor Category in the tree.

The Labor Category list appears in the display area.

2. Click the Category button.

A pull-down menu appears allowing you to select the desired function:

Prices Menu Button 

See “Pricing Schedule Setup” on page 7-1.

Menu Option Description

Statistics Select this option to view sales and capacity statistics 
for the Labor Category.

Comments Select comments to add comments.

Dimensions This selection allows you to view default dimensions. 
6-2

User’s Manual



Chapter 7: Pricing Schedule Setup
In This Chapter

• Schedule Menu 
Button
Pricing schedules are used to setup company wide pricing 
schedules such as the GSA Schedule. Prices can be setup for 
multiple time periods.

To access the Pricing Schedule:

1. Click the Pricing Schedule in the tree.

The Pricing Schedule appears in the display area.

2. Insert, modify, or delete rows as desired.

Enter the pricing schedule code and the name.

Schedule Menu Button

To enter Schedule menu button information:

1. Click the Pricing Schedule in the tree.

The Pricing Schedule appears in the display area.
2. Add, delete, or modify rows.

Enter the pricing schedule code and the description.

3. Click the Schedule button.

A pull-down menu appears allowing you to select the desired 
function:.

Option Description

Prices This table supplies prices specific to a schedule. 

Resource Default Select a particular person to work on the labor category. 
This ties a person to the labor category for a pricing 
schedule.
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Chapter 8: Customer Card Setup
In This Chapter

• New Customers

• Existing 
Customers

• General tab

• Communication 
tab

• Invoicing tab

• Payment stab

• Shipping tab

• Foreign Trade 
tab

• Commerce 
Portal tab

• Customer menu 
button
The customer card allows you set up information about your 
customers.

Creating New Customer Records

You can create new customer records.

To create a new Customer record:

1. Click the Customers card in the tree.

The Customer card appears in the display area.
2. Place your cursor in the No. field and Press F3.

The card is repopulated with blank fields.

3. Click the General tab.

The card is repopulated with General tab information.

Note: When creating a new record, the General tab appears on top.

4. Type the Customer Number.

You can enter notes by clicking the pencil icon.

To view all customers set up in the system press the list key 
located on the toolbar. 

5. Enter the Customer Description.

Type the description of the customer. The maximum number of 
characters is 30. 

6. Enter General tab information as described in “General Tab” on 
page 8-2.

7. Click the Communication tab

The card is repopulated with Communication tab information. 

8. Enter Communication tab information as described in 
“Communication Tab” on page 8-3.

9. Click the Invoicing tab

The card is repopulated with Invoicing tab information. 

10. Enter Invoicing tab information as described in “Invoicing Tab” on 
page 8-4.

11. Click the Payments tab

The card is repopulated with Payments tab information. 
12. Enter Payments tab information as described in “Payments Tab” 

on page 8-5.
8-1



Modifying Existing Customer Records

Customer Card Setup
13. Optionally, enter information in the Shipping, Foreign Trade, and Commerce Portal 
tabs.

Shipping tab information is described in “Shipping Tab” on page 8-5.

Foreign Trade tab information is described in “Foreign Trade Tab” on page 8-6.

Commerce Portal tab information is described in “Commerce Portal Tab” on page 8-6.

14. As desired, view information in the Customer menu button. See “Customer Menu 
Button” on page 8-6.

Modifying Existing Customer Records

You can modify existing Customer records.

To modify Customer records:

1. Click the Customers card in the tree.

The Customer card appears in the display area.

2. Select the desired Customer Number by clicking the list icon while in the No. field.

The Customer list window appears. 
3. Select the desired customer’s row and click OK.

4. Make changes as desired for each tab and menu button option as described in this 
chapter.

General Tab

The General tab is where the basic information is inputted for each Customer.

To enter information in the General tab:

1. Click the Customers card in the tree.

The Customer card appears in the display area.
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2. Click the General tab.

The card is repopulated with General tab information.

You can add a new record as described in “Adding New Records in Card Windows” on 
page 3-10 or you may modify records as described in “Modifying Existing Customer 
Records” on page 8-2. You may also enter the number manually. You can enter notes by 
clicking the pencil icon.

3. Type the Name of the Customer. 

The maximum number of character is 30. 

4. Enter Customer Contact information.

This includes address country code, phone number, and primary contact name and 
search name.

5. Enter the balance and credit limit on the customer account.

6. Select the Salesperson’s code assigned to the Contact.

7. If desired, select if the customer is blocked.

Select this if you are no longer invoicing or if the customer is in excess of credit.

Note: CFR Responsibility Center and Service Zone Code are not used.

Communication Tab

The Communication tab contains additional contact information.

To enter information in the Communication tab:

1. Click the Customers card in the tree.

The Customer card appears in the display area.
2. Click the Communication tab.

The card is repopulated with Communication tab information

3. Enter the e-mail address, home page, and IC partner code.

Enter the e-mail address you wish to have any type of correspondences or campaign sent 
to. An option to send e-mails directly from the customer card is available by clicking the 
icon to the right of the field. 
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Invoicing Tab

Customer Card Setup
Invoicing Tab

The Invoicing tab provides invoicing information for the customer.

To enter information in the Invoicing tab:

1. Click the Customers card in the tree.

The Customer card appears in the display area.

2. Click the Invoicing tab.

The card is repopulated with Invoicing tab information.

3. Enter the number of invoice copies and the Invoice discount code.

4. Select whether to copy the sell-to address to company or person.

5. Enter Tax-related information.

Place a checkmark in Tax Liable if the transaction is liable for taxation; if the field is left 
blank (default), it is considered a non-taxable transaction. 

Navision uses the Tax Area Code, in combination with the Tax Group Code on the sales 
line, to determine the tax rate and the General Ledger accounts for tax posting.

6. Enter Posting Group Information.

General Posting and Customer Posting Group are required. These control how the 
invoice records revenue to G/L accounts. These setups are configured based on client 
requirements.

7. If desired, check Allow line Disc.

8. If desired, check Prices including tax if the price does include tax.

This does not apply to US clients.

9. Select the Department Code. 
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Customer Card Setup
Payments Tab

The payment tab defines the terms of payment for the customer.

To enter information in the Payment tab:

1. Click the Customers card in the tree.

The Customer card appears in the display area.

2. Click the Payments tab.

The card is repopulated with Payments tab information.

3. Select whether the application method is manual or apply to oldest.

4. Define the terms of payment.

Select the Payment Terms Code, Payment Method Code, Reminder Terms Code and 
finance charge code.

5. If desired, check the box to Print Statements.

6. If desired, check the box to Block Payment tolerance.

Shipping Tab

The shipping tab allows you to set shipping parameters. for shipping product.

To enter information in the Shipping tab:

1. Click the Customers card in the tree.

The Customer card appears in the display area.

2. Click the Shipping tab.
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Foreign Trade Tab

Customer Card Setup
The card is repopulated with Shipping tab information.

3. Enter the Location Code for the warehouse from which this order is shipped.

4. If desired, check the box to combine shipments.

5. Select whether shipping is never, always, or optionally reserved for this customer.

6. Select whether shipping advice is partial or complete.

7. Select the Shipment Method and Shipping Agent code as well as the Shipping agent 
service.

8. Enter the Shipping Time.

9. Select the Base Calender Code.

10. Enter Yes or No for a Customized Calendar.

Foreign Trade Tab

This tab is not used.

Commerce Portal Tab

This tab is not used.

Customer Menu Button

The Customer Menu Button allows you to view information related to customers.

To enter Customer menu button information:

1. Click the Customers card in the tree.

The Customer card appears in the display area.

2. Click the Customer button.
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A pull-down menu appears allowing you to select the desired function:

Option Description

List Displays the complete customer list.

Statistics Displays sales document statistics for the current document.

Ledger Entries View Customer ledger entries.

Issued Documents View issued reminders and issued finance charge memos.

Bank Accounts Provides access to the customer bank account card.

Ship-to Addresses Provides access to the customer ship-to address card.

Contact Allows you to create a contact for the customer.

Comments Allows you to enter comments about a particular document.

Dimensions Displays Dimension Codes and Dimension Values for the sales 
document you accessed the feature from.

Statistics by Currencies View statistics by currencies.

Entry Statistics View Entry statistics.

Sales View sales statistics.

Cross References View item cross references.

Service Contracts View service contracts.

Service Items Views service items.

Jobs Allows access to the Job card.

Commerce Portal View the commerce portal contact list.
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Chapter 9: Vendor Card Setup
In This Chapter

• New Vendors

• Existing 
Vendors

• General tab

• Communication 
tab

• Invoicing tab

• Payments tab

• Receiving tab

• Foreign Trade 
tab

• Commerce 
Portal tab

• Vendor menu 
button
The vendor card allows you set up information about your 
vendors.

Creating New Vendor Records

You can create new vendor records.

To create a new Vendor record:

1. Click the Vendors card in the tree.

The Vendor card appears in the display area.
2. Place your cursor in the No. field and Press F3.

The card is repopulated with blank fields.

3. Click the General tab.

The card is repopulated with General tab information.

Note: When creating a new record, the General tab appears on top.

4. Type the Vendor Number. in the No. field.

You can enter notes by clicking the pencil icon.

To view all projects set up in the system press the list key located 
on the toolbar. 

5. Enter the Vendor Description.

Type the description of the Vendor. The maximum number of 
characters is 30. 

6. Enter General tab information as described in “General Tab” on 
page 9-2.

7. Click the Communication tab.

The card is repopulated with Communication tab information. 

8. Enter Communication tab information as described in 
“Communication Tab” on page 9-3.

9. Click the Invoicing tab.

The card is repopulated with Invoicing tab information. 

10. Enter Invoicing tab information as described in “Invoicing Tab” on 
page 9-4.

11. Click the Payments tab.

The card is repopulated with Payments tab information. 
12. Enter Payments tab information as described in “Payments Tab” 

on page 9-5.
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Modifying Existing Vendor Records

Vendor Card Setup
13. Optionally, enter information in the Receiving, Foreign Trade, and Commerce Portal 
tabs.

Receiving tab information is described in “Receiving Tab” on page 9-6.

Foreign Trade tab information is described in “Foreign Trade Tab” on page 9-6.

Commerce Portal tab information is described in “Commerce Portal Tab” on page 9-6.

14. As desired, view information in the Vendor menu button. See “Vendor Menu Button” on 
page 9-7.

Modifying Existing Vendor Records

You can modify existing vendor records.

To modify Vendor records:

1. Click the Vendors card in the tree.

The Vendor card appears in the display area.

2. Select the desired Vendor Number by clicking the list icon while in the No. field.

The Vendor list window appears. 
3. Select the desired vendor’s row and click OK.

4. Make changes as desired for each tab and menu button option as described in this 
chapter.

General Tab

The General tab is where the basic information is input for each Vendor.

To enter information in the General tab:

1. Click the Vendors card in the tree.

The Vendor card appears in the display area.
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2. Click the General tab.

The card is repopulated with General tab information.

You can add a new record as described in “Adding New Records in Card Windows” on 
page 3-10 or you may modify records as described in “Modifying Records in Card 
Windows” on page 3-11. You may also enter the number manually. You can enter notes 
by clicking the pencil icon.

3. Type the Name of the Vendor. 

The maximum number of characters is 30. 

4. Enter Vendor Contact information.

This includes address country code, phone number, and primary contact name and 
search name.

5. View the balance on the vendor account.

6. Select the Purchaser’s code assigned to the Contact.

7. If desired, select if the vendor is blocked.

Select this if you are no longer invoicing or if the vendor is in excess of credit.

Note: Responsibility Center and RFC are not used.

Communication Tab

The Communication tab contains additional contact information.

To enter information in the Communication tab:

1. Click the Vendors card in the tree.

The Vendor card appears in the display area.
2. Click the Communication tab.

The card is repopulated with Communication tab information.

3. Enter the e-mail address, home page, and IC partner code.

Enter the e-mail address you wish to have any type of correspondences or campaign sent 
to. An option to send e-mails directly from the vendor card is available by clicking the 
icon to the right of the field. 
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Vendor Card Setup
Invoicing Tab

The Invoicing tab provides invoicing information for the vendor.

To enter information in the Invoicing tab:

1. Click the Vendors card in the tree.

The Vendor card appears in the display area.

2. Click the Invoicing tab.

The card is repopulated with Invoicing tab information.

3. Enter the Pay-to vendor number.

4. Place a checkmark in Tax Liable if the transaction is liable for taxation.

If the field is left blank (default), it is considered a non-taxable transaction. 

Navision uses the Tax Area Code, in combination with the Tax Group Code on the sales 
line, to determine the tax rate and the General Ledger accounts for tax posting.

Note: This function is typically not used for vendors.

5. Enter Posting Group Information.

General Posting and Vendor Posting Group are required. These control how the invoice 
records revenue to G/L accounts. These setups are configured based on client 
requirements.

6. Enter the Invoice discount code.

7. If desired, check Prices including tax if the price does include tax.

This does not apply to US clients.
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Payments Tab

The payments tab defines the terms of payment for the vendor.

To enter information in the Payments tab:

1. Click the Vendors card in the tree.

The Vendor card appears in the display area.

2. Click the Payment tab.

The card is repopulated with Payments tab information.

3. Select whether the application method is manual or Apply to oldest.

4. Define the terms of payment.

Select the Payment Terms Code, Payment Method Code, Reminder Terms Code and 
finance charge code.

5. Enter the 1099 Code.

You can view these IRS codes by clicking the lookup arrow. This shows the IRS 1099 
codes to select for that center. Click OK to return to the Vendor card.

6. Enter federal ID and Tax information.

7. Enter your account number with the vendor.

8. If desired, check the box to Block Payment tolerance.

This is used to remove special allowances for payment.
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Vendor Card Setup
Receiving Tab

The receiving tab allows you to set receiving parameters for receiving products.

To enter information in the Receiving tab:

1. Click the Vendors card in the tree.

The Vendor card appears in the display area.

2. Click the Receiving tab.

The card is repopulated with Receiving tab information.

3. Enter the Location Code for the warehouse from which this order is received.

4. Select the Shipment Method Code and Shipping Agent Code.

5. Enter the Lead Time Calculation.

6. Select the Base Calender Code.

7. Enter Yes or No for a Customized Calendar.

Foreign Trade Tab

This tab is not used.

Commerce Portal Tab

This tab is not used.
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Vendor Menu Button

The Vendor Menu Button allows you to view information related to vendors.

To enter Vendor menu button information:

1. Click the Vendors card in the tree.

The Vendor card appears in the display area.

2. Click the Vendor button.

A pull-down menu appears allowing you to select the desired function:

Option Description

List Displays the complete vendor list.

Statistics Displays statistics for the current document.

Ledger Entries View vendor ledger entries

Issued Documents View issued reminders and issued finance charge memos.

Bank Accounts Provides access to the vendor bank account card.

Ship-to Addresses Provides access to the vendor ship-to address card.

Contact Allows you to create a contact for the vendor.

Comments Allows you to enter comments about a particular document.

Dimensions Displays Dimension Codes and Dimension Values for the sales 
document you accessed the feature from.

Statistics by Currencies View statistics by currencies.

Entry Statistics View Entry statistics.

Sales View sales statistics.

Cross References View item cross references.

Service Contracts View service contracts.

Service Items Views service items.

Jobs Allows access to the Job card.

Commerce Portal View the commerce portal contact list.
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Chapter 10: Time Journal Activities
In This Chapter

• Importing Time

• Exporting Time

• Making 
Adjustments

• Line menu 
button

• Time menu 
button

• Posting menu 
button
A Project Time Journal is typically used for making time 
adjustments or importing and exporting time for the payroll 
system.

Importing the Time Journal

You must import time from the web before making any 
adjustments to the time journal.

To import time into the Time Journal:

1. Click Time Journal in the tree.

The Project Time Journal appears in the display area.

2. Import time from the web by clicking the Time button and 
selecting Payroll Import/Export and then Web Time Import.

Note: Make sure time has been approved via the web before importing.
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Exporting Time

Time Journal Activities
3. Enter the payroll starting date and click OK.

You can enter a specific employee to import by selecting the resource filter.

4. Use the Missing Time report to investigate and take action on missing time. See 
“Missing Time” on page 19-1.

5. Make any time changes on the Web, make sure they are approved and resubmit via the 
web.

6. Highlight all rows in the Time Journal table and delete them.

7. Import time from the web by clicking the Time button and selecting Payroll Import/
Export and then Web Time Import.

8. Enter the payroll starting date and click OK.

9. Calculate Labor Distributions as desired by clicking the Time button and selecting Calc 
Labor Dist 1-2 Week Cycle or Calc Labor Dist Semi Mo. Cycle.

Exporting Time

You can export time from the journal to your payroll system. 

Note: This function must be performed before time is posted from the Time Journal.

To export time via the Time Journal to a payroll system:

1. Click Time Journal in the tree.

The Project Time Journal appears in the display area.

2. Export time from the journal by clicking the Time button and selecting the payroll 
system.

For ADP, select ADP Export and go to step 3. For Paychex, select Paychex Export and 
the export is complete.
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3. Re-Import the ADP file by clicking the Time button and selecting Payroll Import/Export 
and then ADP Import.

Note: This function is typically not used.

Making Adjustments

Once time is imported, you can make adjustments. such as prices or labor categories.

Note: Changes made in the Time Journal are not synchronized with the Web. This will cause 
inconsistencies with the modules.

To make adjustments to the Time Journal:

1. Click Time Journal in the tree.

The Time Journal appears in the display area.
2. If desired, create or select the desired Batch Name.

3. Insert, modify, or delete rows as desired.

Total cost must be populated for Cost Plus. Total price must be populated for T&M. If 
these are not defined the invoicing will be incorrect.

Field Description

Posting Date Date labor is recorded.

Document No. Number of the batch document.

Resource Number of the resource.

Project Number of the project.

WBS Code WBS code.

Pay Type Whether it is overtime, holiday work, shift2/3, regular. System normally 
defaults to regular.

Labor Posting 
group

Labor posting group.

Department code The department code.

Labor category The labor category.

Quantity Number of hours

Total Cost Total Cost

Total Price Represents the amount to be billed to the client.
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Line Menu Button

The Line menu button items allow you to view detail related to the Time Journal.

To view Line menu button information:

1. Click the Time Journal card in the tree.

The Time Journal card appears in the display area.

2. Click the Line button.

A pull-down lists the Dimensions option which displays Dimension Codes and 
Dimension Values for the Resource line you accessed. 

Time Menu Button

The Time menu button allows you to calculate labor cost and distribution, import and 
export payroll data, and create subcontractor invoices.

To enter Time menu button information:

1. Click the Time Journal card in the tree.

The Time Journal card appears in the display area.
2. Click the Time button.

A pull-down menu appears allowing you to select the desired function:

Menu Item Description

Card This menu item allows you to toggle back to the resource card.

Ledger Entries This option allows you to view prior postings for the current resource. 

Calculate Labor Rate This option allows you to calculate the cost based upon the number of hours 
worked for the week. This function uses the Payroll Rate field on the 
resource card in determining the amount.

Create Comp Time entries Used for clients where employees can accrue compensation time.

Calc Labor Dist 1-2 Week 
Cycle

The functions allow you to calculate labor distributions for when your pay 
cycle is 1 or 2 weeks.

Calc Labor Dist Semi mo. 
Cycle

The functions allow you to calculate labor distributions for when your pay 
cycle is twice monthly.

Payroll Import/Export

Web Time import

Web Time Import is used to import the time from the Web time entry 
system. This updates the time journal from the entries that were made by 
the Web time entry. 

Payroll Import/Export

ADP Import and Export

When you export time, Navision creates a file that the ADP system loads 
into the Payroll database. Once Payroll is processed, ADP then sends a file 
back with the actual pay amounts including the fringe entries. You then use 
the ADP Import option imported back into Navision updating the project 
time journal with the actual cost of the entries. 
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Posting Menu Button

The Posting menu button allows you to record transactions.

To enter Posting menu button information:

1. Click the Time Journal card in the tree.

The Time Journal card appears in the display area.
2. Click the Posting button.

A pull-down menu appears allowing you to select the desired function:.

Payroll Import/Export

Paycheck Export

This function is used to export the Time journal to Paychex. 

Create Sub-Contractor 
Invoice

When a company has subcontractors that use Web Time entry to submit 
time, this option moves their time to a purchase order for creating accounts 
payable.

Menu Item Description

Menu Item Description

Test Report The test report is Navision’s Edit report. The system 
prints out the entries from the time journal in a report. 
You can then review your work before you post the 
journal. Once the journal is posted you are not able to re-
run the test report. You can review error messages 
displayed in the test report and take appropriate action.

Post This option allows you to post the entries to the system. 
Once posting is completed, the system will clear the 
journal. Navision makes entries to the resource ledger, the 
project ledger, and the general ledger.

Post and Print This runs the same function, as the Post option, but it 
prints out a register report for you. 
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Chapter 11: Project Journal Activities
In This Chapter

• Line menu 
button

• Time menu 
button

• Posting menu 
button

• Functions menu 
button
A Project Journal is typically used for making adjustments or 
exceptional transactions, such as transfers from one project to 
another. Changes to the Project Journal are reflected in the 
Project Ledger. Labor adjustments must be made through the 
Time Journal.

To make adjustments to the Project Journal:

1. Click Project Journal in the tree.

The Project Journal appears in the display area.

2. If desired, create or select the desired Batch Name.

3. Insert, modify, or delete rows as desired.

Field Description

Posting 
Date

Date transaction is recorded.

Document 
No.

Number of the batch document.

Resource Number of the resource.

Project Number of the project.

WBS Code WBS code.

Type Whether it is G/L or resource.

Labor 
Posting 
group

Labor posting group.

Department 
code

The department code.
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Line Menu Button

The Line Menu Button allows you to view information related to the Project Journal.

To view Line menu button information:

1. Click the Project Journal card in the tree.

The Project Journal card appears in the display area.

2. Click the Line button.

A pull-down lists the Dimensions option which displays Dimension Codes and 
Dimension Values for the Resource line you accessed. 

Project Menu Button

The Project menu button allows you access to the Project card and ledger entries.

To enter Project menu button information:

1. Click the Project Journal card in the tree.

The Project Journal card appears in the display area.

2. Click the Project button.

A pull-down menu appears allowing you to select the desired function:

Labor 
category

The labor category.

Quantity Quantity to adjust.

Total Cost The total cost

Total Price  Represents the amount to be billed to the client.

Sub type  Describe the type of entry...list from pulldown.

Balancing 
Account 
number

 Invokes the G/L Account list. Select the G/L account number.

Unit of 
Measure 
Code

 The Unit of measure code.

Unit Costs 
and Price

 Helps calculate the total cost or price.

Field Description

Menu Item Description

Card This allows you to toggle to the Project Card of the current line in the 
project journal

Ledger Entries This option allows you to see the history of the Project of the current line. 
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Functions Menu Button

The Functions menu button allows you to copy ledger entries.

To enter Functions menu button information:

1. Click the Project Journal card in the tree.

The Project Journal card appears in the display area.

2. Click the Functions button.

A pull-down menu appears allowing you to Copy Ledger entries.

Posting Menu Button

The Posting menu button allows you to record transactions.

To enter Posting menu button information:

1. Click the Project Journal card in the tree.

The Project Journal card appears in the display area.

2. Click the Posting button.

A pull-down menu appears allowing you to select the desired function:

Menu Item Description

Test Report The test report is Navision’s Edit report. The system 
prints out the entries from the time journal in a report. 
You can then review your work before you post the 
journal. Once the journal is posted you are not able to re-
run the test report. You can review error messages 
displayed in the test report and take appropriate action.

Post This option allows you to post the entries to the system. 
Once posting is completed, the system will clear the 
journal. Navision makes entries to the resource ledger, the 
project ledger, and the general ledger.

Post and Print This runs the same function, as the Post option, but it 
prints out a register report for you. 

Reconcile You can see the change in accounts that are set up for 
reconciliation. (GL setup) The system displays the net 
change and the balance after posting.
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Chapter 12: Order Processing Purchase 
Activities
In This Chapter

• Purchase Order 
card

• Order 
Receiving

• Order Invoicing

• Invoices

• Credit Memos
Order Processing consists of a Purchase and a Sales folder. 
Windows related to purchasing are discussed in this chapter. 
Order processing purchasing activities are executed from these 
cards. The cards in this folder provide the same functionality as 
those in the Navision Purchase Module.

It is important to understand the order of purchasing activities in 
Project Accounting. This order is outlined below:

1. Quotes.

If you use quotes, they are generated using Requisition 
Worksheets in the Logistics and Planning folder. See 
“Requisition Worksheet” on page 16-4.

2. Purchase Order.

Purchase orders are created via the Purchase Order card. See 
“Purchase Order Card” on page 12-1.

3. Purchase Receiving.

Receiving is recorded via the Purchase Receiving card. See 
“Order Receiving” on page 12-9.

4. Purchase Invoicing.

Invoicing is recorded via the Purchase Invoice card. See “Order 
Invoicing” on page 12-10.

5. Purchase Credit Memo.

Credit is recorded via the Purchase Credit Memo card. See 
“Credit Memos” on page 12-11.

Purchase Order Card

The Purchase Order card is used to set up Purchase Orders and 
allows you to define Vendors, Shipping, and Invoicing 
information. It allows you to Post the order from this screen 
instead of having to navigate to another module to complete 
posting. Navision allows the purchase order to be e-mailed to the 
customer and allows you to send an HTML file. In general, you 
enter all desired information into the card and then post the order.
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Purchase Order Card

Order Processing Purchase Activities
General Tab

The General tab allows you to enter basic information about the order. 

To enter information in the General tab:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.
2. Click the expansion symbol for the Purchase folder.

A list of cards is displayed.

3. Click Order.

The Purchase Order card appears in the display area.

4. Click the General tab.

The card is repopulated with general tab information.

5. Press F3 to create a new purchase order.

6. Enter a Purchase Order Number.

7. Enter Buy-from information.

This is contact information for the vendor from which you are purchasing.

8. Enter the Order address code, Purchase code and Requisition Number.

9. Enter line items in the Purchase Order table as desired. See “Purchase Order Table” on 
page 12-3.
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Purchase Order Card
Order Processing Purchase Activities
Purchase Order Table

The table is located on all tabs in the Purchase Order Card but should be filled out when 
using the General tab. It details the items that are going to be shipped. You may insert, 
delete, or modify fields in this table as described in the table below.

Purchase Order 
Table

Field Description

Type General Ledger, Item, Fixed Asset, or Charge (Item).

No. Click on the drop down Menu and choose the 
corresponding GL, fixed asset or item.

Project No. Enter the appropriate project #.

WBS Code If this field is required, click the drop down arrow, the 
system displays the codes associated with the Project No.

Description Defaults to the item’s description.

Quantity Enter quantity to order.

Unit of Measure Hour or each.

Unit Cost ($) What the vendor is charging for 1 item.

Labor Category Select the labor category to bill labor categories to the 
client. Labor category is used when the vendor is 
providing sub contract labor that needs to be invoiced to 
the client.

Unit Price Price per hour that the client is invoiced.

Logistics Item No. Number used by logistics module to track the flow of the 
item.
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Purchase Order Card

Order Processing Purchase Activities
Shipping Tab

The Shipping tab allows you to enter basic information about the order. 

To enter information in the Shipping tab:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.
2. Click the expansion symbol for the Purchase folder.

A list of cards is displayed.

3. Click Order.

The Purchase Order card appears in the display area.

4. Click the Shipping tab

The card is repopulated with shipping tab information.

5. Enter Ship-to information.

6. Enter the location Code.

7. Enter the shipping method code.

8. Sell-to Customer No.

Once you choose this the system completes the Ship-to Name, Address, Contact and 
City/Zip Code.
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Purchase Order Card
Order Processing Purchase Activities
Invoicing Tab

This tab determines the Vendor invoiced and indicates who the contact is that receives 
the invoice either by e-mail or mail. 

To enter information in the Invoicing tab:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.
2. Click the expansion symbol for the Purchase folder.

A list of cards is displayed.

3. Click Order.

The Purchase Order card appears in the display area.

4. Click the Invoicing tab.

The card is repopulated with invoicing tab information.

5. Select the Pay-to Vendor and Contact.

6. Select Department, Project and Payment Terms codes.

7. Enter the Due date.

8. Enter the Payment Discount percentage and the due date.

9. Enter Tax information.
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Purchase Order Card

Order Processing Purchase Activities
Foreign Trade Tab

This tab is not used. 

E-Commerce Tab

This tab is not used. 

Posting the Purchase Order

The Posting menu button allows you to record transactions.

To enter Posting menu button information:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.
2. Click the expansion symbol for the Purchase folder.

A list of cards is displayed.

3. Click Order.

The Purchase Order card appears in the display area.

4. Click the Posting button.

A pull-down menu appears allowing you to select the desired function:.

Menu Item Description

Test Report The test report is Navision’s Edit report. The system 
prints out the entries from the time journal in a report. 
You can then review your work before you post the 
journal. Once the journal is posted you are not able to re-
run the test report. You can review error messages 
displayed in the test report and take appropriate action.

Post This option allows you to post the entries to the system. 
Once posting is completed, the system will clear the 
journal. Navision makes entries to the resource ledger, the 
project ledger, and the general ledger.

Post and Print This runs the same function, as the Post option, but it 
prints out a register report for you. 

Post Batch If you have set up a large number of purchase orders, it is 
an advantage to post them with a batch job in the 
program. You can have them posted at night or at another 
time when it is convenient.
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Purchase Order Card
Order Processing Purchase Activities
Order Menu Button

The Order menu button allows you to view information related to the order.

To view Order menu button information:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.
2. Click the expansion symbol for the Purchase folder.

A list of cards is displayed.

3. Click Order.

The Purchase Order card appears in the display area.

4. Click the Order button.

A pull-down menu appears allowing you to select the desired function:

Line Menu Button

The Line menu button allows you to view Items by availability.

To view Line menu button information:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.

2. Click the expansion symbol for the Purchase folder.

A list of cards is displayed.
3. Click Order.

The Purchase Order card appears in the display area.

4. Click the Line button.

Menu Item Description

List View all purchase orders in the system.

Statistics View summary information.

Card Invoke the Vendor card.

Comments Add comments.

Receipts View receipts.

Invoices View invoices.

Dimensions View default dimensions.

Whse. receipt 
Lines

Not used.

Invt. Put-away/
Pick Lines

Not used.

Drop Shipment  Not used.

Special Order Not Used.
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Purchase Order Card

Order Processing Purchase Activities
A pull-down menu appears allowing you to select the desired function:

Functions Menu button 

The Functions menu button allows you ton perform actions related to processing the 
order.

To enter Functions menu button information:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.
2. Click the expansion symbol for the Purchase folder.

A list of cards is displayed.
3. Click Order.

The Purchase Order card appears in the display area.

4. Click the Functions button.

A pull-down menu appears allowing you to select the desired function:

Menu Item Description

Item Availability 
by

Period, Variant, or Location.

Reservation 
Entries

Not used.

Item Tracking lines Not used.

Dimensions Not used.

Item Charge 
Assignment

Not used.

Menu Item Description

Calculate Invoice 
Discount

Calculates the invoice discount.

Explode BOM Explodes the Bill of Materials.

Insert Ext Texts Inserts Extended text.

Get Standard Vend. 
Purchase Codes

Retrieves the standard vendor purchase codes.

Get Phase/Task/
Step

Not used.

Reserve Not used.

Order Tracking Not used.

Copy Document Available if you have the archiving function.

Archive Document Available if you have the archiving function.

Move Negative 
Lines

When you enter a purchase return, you can use this 
batch job to delete a negative purchase line from the 
document you are working in and move it to a different 
purchase document type.
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Order Receiving
Order Processing Purchase Activities
Order Receiving

Order Receiving is performed when goods are received. Verify the order. If only a 
partial order has been received, before posting edit the quantity field in the table to 
indicate the remaining items to be received.

General Tab

The fields on this tab are similar to the options on the General tab of the Purchase Order 
card. See “General Tab” on page 12-2. Any text in the On Hold field indicates that the 
receiving is on hold.

Shipping Tab

The Shipping tab on this window is exactly the same as on the Purchase Order card. See 
“Shipping Tab” on page 12-4.

Menu Buttons

The menu buttons on this window are exactly the same as on the Purchase Order card. 
See “Purchase Order Card” on page 12-1.

Create Whse 
Receipt

Not used.

Create Inventory 
Put-away/Pick

Not used.

Release This option closes the order and changes can not be 
made. 

Reopen Used to open a released order.

Send BizTalk 
Purchase 

Not used.

Send IC Purchase 
Order

Not used.

Menu Item Description
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Order Invoicing

Order Processing Purchase Activities
Order Invoicing

Perform Order Invoicing after the goods have been received. Post to create an accounts 
payable invoice.

General Tab

The fields on this tab are similar to the options on the General tab of the Purchase Order 
card. See “General Tab” on page 12-2.

Invoicing Tab

The fields on this tab are a subset of the same tab on the Purchase Order card. See 
“Invoicing Tab” on page 12-5.

Menu Buttons

The menu buttons on this window are exactly the same as on the Purchase Order card. 
See “Purchase Order Card” on page 12-1.

Invoices

If you have a payable where a quote, purchase order, and receiving is not necessary, you 
can create an invoice here.

General Tab

The fields on this tab are similar to the options on the General tab of the Purchase Order 
card. See “General Tab” on page 12-2

Invoicing Tab

The fields on this tab are a subset of the same tab on the Purchase Order card. See 
“Invoicing Tab” on page 12-5.

Menu Buttons

The menu buttons on this window are a subset of the same buttons on the Purchase 
Order card. The Invoice button is a subset of the options in the Order button. See 
“Purchase Order Card” on page 12-1.
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Credit Memos
Order Processing Purchase Activities
Shipping Tab

The Shipping tab on this window is exactly the same as on the Purchase Order card. See 
“Shipping Tab” on page 12-4.

Foreign Trade Tab

The Foreign tab on this window is exactly the same as on the Purchase Order card. See 
“Foreign Trade Tab” on page 12-6.

E-commerce Tab

The E-commerce tab on this window is exactly the same as on the Purchase Order card. 
See “E-Commerce Tab” on page 12-6.

Credit Memos

Credit Memos are created if you have a return and need to issue credit.

General Tab

The fields on this tab are similar to the options on the General tab of the Purchase Order 
card. See “General Tab” on page 12-2

Invoicing Tab

The fields on this tab are exactly the same as on the Purchase Order card. See “Invoicing 
Tab” on page 12-5.

Shipping Tab

The Shipping tab on this window is exactly the same as on the Purchase Order card. See 
“Shipping Tab” on page 12-4.

Foreign Trade Tab

The Foreign Trade tab on this window is exactly the same as on the Purchase Order 
card. See “Foreign Trade Tab” on page 12-6.

Application Tab

The Application tab indicates where to apply the credit.
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Credit Memos

Order Processing Purchase Activities
To enter information in the Application tab:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.

2. Click the expansion symbol for the Purchase folder.

A list of cards is displayed.

3. Click the Credit Memo Card.

The Credit Memo card appears in the display area.
4. Click the Application tab.

The card is repopulated with Application tab information.

5. Select the Doc-type, Number, and ID to which the Credit Memo applies.

E-commerce Tab

The E-commerce tab on this window is exactly the same as on the Purchase Order card. 
See “E-Commerce Tab” on page 12-6.

Menu Buttons

The menu buttons on this window are a subset of the same buttons on the Purchase 
Order card. The Invoice Button is a subset of the options in the Order button. See 
“Purchase Order Card” on page 12-1.
12-12

User’s Manual



Chapter 13: Order Processing - Purchase History
In This Chapter

• Order 
Modifications

• Posted Invoices

• Posted 
Shipments

• Posted Credit 
Memos

• Posted 
Receipts

• Registers

• Navigate
Order processing history allows you to review order processing 
activities for posted purchasing documents. You can use the back 
and forth arrows on the toolbar to move back and forth through 
the number series.

Order Modifications

This selection displays all posted purchase orders.

To view information in the Posted Invoices Card:

1. Click the Order Processing Folder expansion symbol (+) in the 
tree.

The tree expands to reveal two folders.

2. Click the expansion symbol for the Purchase folder.

A list of cards and folders is displayed.
3. Click the expansion symbol for the History folder.

A list of cards is displayed.
4. Click the Order Modifications card.

The Purchase Order Archive card appears in the display area.

5. Use the back and forth arrows on the toolbar to move back and 
forth through the number series to review records.

General Tab

The fields on this tab are similar to the options on the General tab 
of the Purchase Order card. See “General Tab” on page 12-2.

Invoicing Tab

The Invoicing tab on this window is exactly the same as on the 
Purchase Order card. See “Invoicing Tab” on page 12-5.

Shipping Tab

The Shipping tab on this window is exactly the same as on the 
Purchase Order card. See “Shipping Tab” on page 12-4.
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Posted invoices

Order Processing - Purchase History
Foreign Trade Tab

The Foreign Trade tab on this window is exactly the same as on the Purchase Order card. 
See “Foreign Trade Tab” on page 12-6.

Version Tab

The Version tab displays the modification version number and related information.

This feature is enabled in government contractor setup. “Government Contractor Setup” 
on page 25-2 if the modification module has been purchased.

To view information in the version tab:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.

2. Click the expansion symbol for the Purchase folder.

A list of cards and folders is displayed.
3. Click the expansion symbol for the History folder.

A list of cards is displayed.
4. Click the Posted Invoices Card.

The Order Archive card appears in the display area.

5. Click the Version tab.

The card is repopulated with Version tab information. It displays the Modification No., 
who archived the order, the date and time of archive, and the Interaction Exists 
checkbox.

Menu Buttons

The menu buttons on this window are a subset of the same buttons on the Purchase 
Order card. The Version Button is a subset of the options in the Order button. See 
“Purchase Order Card” on page 12-1.

Posted invoices

This selection displays all posted invoices.

To view information in the Posted Invoices card:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.

2. Click the expansion symbol for the Purchase folder.

A list of cards and folders is displayed.
3. Click the expansion symbol for the History folder.

A list of cards is displayed.
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Posted invoices
Order Processing - Purchase History
4. Click the Posted Invoices Card.

The card appears in the display area.

5. Use the back and forth arrows on the toolbar to move back and forth through the number 
series to review records.

General Tab

The fields on this tab are similar to the options on the General tab of the Purchase Order 
card. See “General Tab” on page 12-2.

Invoicing Tab

The Invoicing tab on this window is exactly the same as on the Purchase Order card. See 
“Invoicing Tab” on page 12-5.

Shipping Tab

The Shipping tab on this window is exactly the same as on the Purchase Order card. See 
“Shipping Tab” on page 12-4.

Foreign Trade Tab

The Foreign Trade tab on this window is exactly the same as on the Purchase Order card. 
See “Foreign Trade Tab” on page 12-6.

Version Tab

The Version tab displays the modification version number and related information.

This feature is enabled in government contractor setup. “Government Contractor Setup” 
on page 25-2 if the modification module has been purchased.

To view information in the version tab:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.

2. Click the expansion symbol for the Purchase folder.

A list of cards and folders is displayed.
3. Click the expansion symbol for the History folder.

A list of cards is displayed.

4. Click the Posted Invoices Card.

The card appears in the display area.

5. Click the Version tab.
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Posted Credit Memos

Order Processing - Purchase History
The card is repopulated with Version tab information. It displays the Modification No., 
who archived the order, the date and time of archive, and the Interaction Exists 
checkbox.

Menu Buttons

The menu buttons on this window are a subset of the same buttons on the Purchase 
Order card. The Version Button is a subset of the options in the Order button. See 
“Purchase Order Card” on page 12-1.

Posted Credit Memos

This selection displays all posted credit memos.

To view information in the Posted Credit Memos Card:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.

2. Click the expansion symbol for the Purchase folder.

A list of cards and folders is displayed.
3. Click the expansion symbol for the History folder.

A list of cards is displayed.
4. Click the Posted Credit Memos Card.

The card appears in the display area.

5. Use the back and forth arrows on the toolbar to move back and forth through the number 
series to review records.

General Tab

The fields on this tab are similar to the options on the General tab of the Purchase Order 
card. See “General Tab” on page 12-2.

Invoicing Tab

The fields on this tab are a subset of the same tab on the Purchase Order card. See 
“Invoicing Tab” on page 12-5.

Shipping Tab

The fields on this tab are a subset of the same tab on the Purchase Order card. See 
“Shipping Tab” on page 12-4.
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Posted Receipts
Order Processing - Purchase History
Foreign Trade Tab

The fields on this tab are a subset of the same tab on the Purchase Order card. See 
“Foreign Trade Tab” on page 12-6.

Menu Buttons

The menu buttons on this window are a subset of the same buttons on the Purchase 
Order card. The Version Button is a subset of the options in the Order button.See 
“Purchase Order Card” on page 12-1. The Navigate button brings up the navigate 
window as described in “Navigate” on page 23-2.

Posted Receipts

This selection displays all posted receipts.

To view information about Posted Receipts:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.

2. Click the expansion symbol for the Purchase folder.

A list of cards and folders is displayed.
3. Click the expansion symbol for the History folder.

A list of cards is displayed.
4. Click the Posted Receipts Card.

The card appears in the display area.

5. Use the back and forth arrows on the toolbar to move back and forth through the number 
series to review records.

General Tab

The fields on this tab are similar to the options on the General tab of the Purchase Order 
card. See “General Tab” on page 12-2.

Invoicing Tab

The fields on this tab are a subset of the same tab on the Purchase Order card. See 
“Invoicing Tab” on page 12-5.

Shipping Tab

The fields on this tab are a subset of the same tab on the Purchase Order card. See 
“Shipping Tab” on page 12-4.
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Registers

Order Processing - Purchase History
BizTalk Tab

This tab is not used.

Menu Buttons

The menu buttons on this window are a subset of the same buttons on the Purchase 
Order card. The Version Button is a subset of the options in the Order button.See 
“Purchase Order Card” on page 12-1. The Navigate button brings up the navigate 
window as described in “Navigate” on page 23-2.

Registers

See “Registers” on page 23-1.

Navigate

See “Navigate” on page 23-2.
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Chapter 14: Order Processing - Sales
In This Chapter

• Invoice 
Worksheets

• Credit Memo

• Create Excel 
Workbook
Order Processing Consists of a purchase and a Sales folder. cards 
related to sales are discussed in this chapter.

Invoice Worksheets

The Invoice worksheet allows you to enter all relevant 
information for creating a sales invoice.

To begin sales order processing:

1. Click the Order Processing Folder expansion symbol (+) in the 
tree.

The tree expand to reveal two folders.
2. Click the expansion symbol for the Sales folder.

A list of cards is displayed.

3. Click Invoice Worksheets.

The Sales Invoice window appears in the display area.
4. Select Create Project Wkst (Single or Multiple) from the 

Functions menu button to create project billing worksheets.

The Create Project Billing Worksheet window appears.

5. Enter the desired information.

By lookup select the Project Number, Task code, and date filter. 
If desired, check the box to invoice by task.

6. Click OK.

7. Check listed information to verify.

Changes can be made in modifiable fields.
8. Post.
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Invoice Worksheets

Order Processing - Sales
General Tab

The General tab allows you to enter basic information about the order. 

To enter information in the General tab:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expand to reveal two folders.
2. Click the expansion symbol for the Sales folder.

A list of cards is displayed.

3. Click Invoice Worksheets.

The Sales Invoice window appears in the display area.

4. Click the General tab.

The window is repopulated with general tab information.

5. Enter a Invoice Order Number.

6. Enter Sell-to information.

This is contact information for the client.
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Invoice Worksheets
Order Processing - Sales
Sales Order Table

The table is located on all tabs in the Invoice Worksheet card but should be modified 
when using the General tab. It details the items that have been sold. It is populated from 
existing information but can be modified as needed. You may insert, delete, or modify 
fields in this table as described in the table below.

Shipping Tab

The Shipping tab allows you to enter basic information about the order. 

To enter information in the Shipping tab:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expand to reveal two folders.

2. Click the expansion symbol for the Sales folder.

A list of cards is displayed.
3. Click Invoice Worksheets.

The Sales Invoice window appears in the display area.

4. Click the Shipping tab.

Field Description

Type General Ledger, Item, Fixed Asset, or Charge Item, 
resource.

No. Click on the drop down Menu and choose the 
corresponding GL , item, or resource.

Project No.: Enter the appropriate project #.

WBS Code If this field is required, click the drop down arrow, the 
system displays the codes associated with the Project No.

Description Defaults to the item’s description.

Quantity Enter quantity to putrchase.

Unit of Measure Hour or each.

Labor Category Labor category defines type of work performed by 
resource or subcontractor.

Unit Price Price per hour that the client is invoiced.

Logistics Item No. Number used by logistics module to track the flow of the 
item.
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Invoice Worksheets

Order Processing - Sales
The card is repopulated with shipping tab information.

5. Enter Ship-to information.

6. Enter the location Code.

7. Enter the shipping method and agent codes.

8. Enter the Package tracking Number.

9. Enter Shipment dates.

Invoicing Tab

This tab determines the customer that will be invoiced and indicates who is the contact 
that receives the invoice either by e-mail or mail. 

To enter information in the Invoicing tab:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expand to reveal two folders.
2. Click the expansion symbol for the Sales folder.

A list of cards is displayed.

3. Click Invoice Worksheets.

The Sales Invoice window appears in the display area.

4. Click the Invoicing tab.
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Invoice Worksheets
Order Processing - Sales
The card is repopulated with invoicing tab information.

5. Select the Bill-to Customer and Contact Number.

6. Select Department, Project and Payment Terms codes.

7. Enter the Due date.

8. Enter the payment Discount percentage and the due date.

9. Enter Tax information.

Foreign Trade Tab

This tab is not used.

Posting Menu Button

The Posting menu button allows you to record transactions.

To enter Posting menu button information:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expand to reveal two folders.
2. Click the expansion symbol for the Sales folder.

A list of cards is displayed.

3. Click Invoice Worksheets.

The Sales Invoice window appears in the display area.

4. Click the Posting button.
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Invoice Worksheets

Order Processing - Sales
A pull-down menu appears allowing you select the desired function.

Invoice Menu Button

The Invoice menu button allows you to view related information.

To enter Invoice menu button information:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expand to reveal two folders.
2. Click the expansion symbol for the Sales folder.

A list of cards is displayed.
3. Click the Invoice Worksheet Card.

The Invoice Worksheet card appears in the display area.

4. Click the Invoice button.

A pull-down menu appears allowing you select the desired function.

Line Menu Button

The Line menu button is not used.

Menu Item Description

Test Report The test report is Navision’s Edit report. The system 
prints out the entries from the time journal in a report. 
You can then review your work before you post the 
journal. Once the journal is posted you are not able to re-
run the test report. You can review error messages 
displayed in the test report and take appropriate action.

Post This option allows you to post the entries to the system. 
Once posting is completed, the system will clear the 
journal. Navision makes entries to the resource ledger, the 
project ledger, and the general ledger.

Post and Print This runs the same function, as the Post option, but it 
prints out a register report for you. 

Post Batch Allows you to batch post sales invoices.

Print Invoice 
Worklist

You can print invoice worksheets before you post.

Menu Item Description

List Displays all invoice worksheets.

Statistics View summary information.

Card Invokes the Customer card.

Comments Allows you to add comments.

Dimensions View default dimensions.
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Invoice Worksheets
Order Processing - Sales
Functions Menu Button 

The Functions menu button allows you to create single and multiple project worksheets.

To enter Functions menu button information:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expand to reveal two folders.
2. Click the expansion symbol for the Sales folder.

A list of cards is displayed.

3. Click Invoice Worksheets.

The Sales Invoice window appears in the display area.

4. Click the Functions button.

A pull-down menu appears allowing you select the desired function.

Menu Item Description

Calculate Invoice 
Discount

Not used.

Explode BOM Not used.

Get Price Not used.

Get Line Discount Not used.

Insert Ext Texts Not used.

Get Standard Sales 
Codes

Not used.

Get Phase/Task/
Step

Not used.

Get Shipment 
Lines

Not used.

Create Project 
Wkst (Single)

Creates a single Project Worksheet.

Create Project 
Wkst (Multiple)

Creates invoices for multiple projects.

Copy Document Not used.

Move Wkst to 
Credit memo

Creates a Credit Memo and is used when the total 
invoice value is negative.

Year End Not used.

Release Not used.

Reopen Not used.
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Credit Memo

Order Processing - Sales
Customer Information Area

The Customer Information area provides options that display information about the 
customer.

Sell-to Customer

These options provide information about the customer to which you are selling. It 
provides the ship-to address, contacts, and sales history for the customer.

Bill-to Customer

Select the paying customer.

Credit Memo

Credit Memos can be issued for sales returns.

General Tab

The fields on this tab are similar to the options on the General tab of the Invoice 
Worksheet. “General Tab” on page 14-2.

Shipping Tab

The Shipping tab on this window are exactly the same as on the Invoice Worksheet. See 
“Shipping Tab” on page 14-3.

Foreign Trade Tab

The fields on this tab are a subset of the same tab on the Invoice Worksheet Card. See 
“Foreign Trade Tab” on page 14-5.
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Create Excel Workbook
Order Processing - Sales
Application Tab

The Application tab lets you specify where to apply credit.

To enter information in the Application tab:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expand to reveal two folders.
2. Click the expansion symbol for the sales folder.

A list of cards is displayed.

3. Click the Credit Memo Card.

The Credit Memo card appears in the display area.

4. Click the Application tab.

The card is repopulated with Application tab information.
5. Select the Doc-type, Number, and ID to which the Credit Memo applies.

Menu Buttons

The menu buttons on this window are a subset of the same buttons on the Invoice 
Worksheet. The Cr. Memo Button is a subset of the options in the Invoice button. See 
“Invoice Worksheets” on page 14-1.

Create Excel Workbook

Before executing this task, you must create your workbook settings in “Creating Sales 
Invoices using Excel ” on page 25-13. The Create Excel Workbook window allows you 
to print the workbook based on the code and month filter.

To print an excel workbook:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expand to reveal two folders.

2. Click the expansion symbol for the Sales folder.

A list of cards is displayed.
3. Click Create Excel Workbook.

The Create Excel Workbook window appears in the display area.
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Create Excel Workbook

Order Processing - Sales
4. Enter the desired code and month filter.

5. Click OK.

A workbook is added to spreadsheet with invoicing data.
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Chapter 15: Order Processing - Sales History
In This Chapter

• Posted Invoices

• Posted 
Shipments

• Posted Credit 
Memos

• Registers

• Navigate
Order processing history allows you to review order processing 
activities for posted sales documents. You can use the back and 
forth arrows on the toolbar to move back and forth through the 
number series.

Posted invoices

This selection displays all posted invoices.

To view information in the Posted Invoices Card:

1. Click the Order Processing Folder expansion symbol (+) in the 
tree.

The tree expands to reveal two folders.

2. Click the expansion symbol for the Sales folder.

A list of cards and folders is displayed.
3. Click the expansion symbol for the History folder.

A list of cards is displayed.
4. Click the Posted Invoices Card.

The card appears in the display area.

5. Use the back and forth arrows on the toolbar to move back and 
forth through the number series to review records.

General Tab

The fields on this tab are similar to the options on the General tab 
of the Invoice Worksheet. See “General Tab” on page 14-2.

Invoicing Tab

The fields on this tab are a subset of the same tab on the Invoice 
Worksheet. See “Invoicing Tab” on page 15-1.

Shipping Tab

The fields on this tab are a subset of the same tab on the Invoice 
Worksheet. See “Shipping Tab” on page 15-1.
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Posted Shipments

Order Processing - Sales History
Foreign Tab

The fields on this tab are a subset of the same tab on the Purchase Order card. See 
“Foreign Trade Tab” on page 14-5.

BizTalk Tab

The Biztalk tab is not used.

Menu Buttons

The menu buttons on this window are a subset of the same buttons on the Invoice 
Worksheet Card. See “Invoice Worksheets” on page 14-1.

Posted Shipments

This selection displays all posted shipments.

To view information in the Posted Shipment Card:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.
2. Click the expansion symbol for the Sales folder.

A list of cards and folders is displayed.

3. Click the expansion symbol for the History folder.

A list of cards is displayed.
4. Click the Posted Shipment Card.

The card appears in the display area.
5. Use the back and forth arrows on the toolbar to move back and forth through the number 

series to review records.

General Tab

The fields on this tab are similar to the options on the general tab of the Invoice 
Worksheet. See “General Tab” on page 14-2.

Invoicing Tab

The fields on this tab are a subset of the same tab on the Invoice Worksheet. See 
“Invoicing Tab” on page 14-4.
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Posted Credit Memos
Order Processing - Sales History
Shipping Tab

The fields on this tab are a subset of the same tab on the Invoice Worksheet. See 
“Shipping Tab” on page 14-3.

Foreign Trade Tab

The fields on this tab are a subset of the same tab on the Invoice Worksheet. See 
“Foreign Trade Tab” on page 14-5.

Menu Buttons

The menu buttons on this window are a subset of the same buttons on the Purchase 
Order card. The Shipment button is a subset of the options in the Order button.See 
“Invoice Worksheets” on page 14-1. The Navigate button brings up the navigate 
window as described in “Navigate” on page 23-2.

Posted Credit Memos

This selection displays all posted credit memos.

To view information in the Posted Credit Memos Card:

1. Click the Order Processing Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.
2. Click the expansion symbol for the Sales folder.

A list of cards and folders is displayed.

3. Click the expansion symbol for the History folder.

A list of cards is displayed.
4. Click the Posted Credit Memos Card.

The card appears in the display area.
5. Use the back and forth arrows on the toolbar to move back and forth through the number 

series to review records.

General Tab

The fields on this tab are similar to the options on the general tab of the Invoice 
Worksheet. See “General Tab” on page 14-2.

Invoicing Tab

The fields on this tab are a subset of the same tab on the Invoice Worksheet. See 
“Invoicing Tab” on page 14-4.
15-3
User’s Manual



Registers

Order Processing - Sales History
Shipping Tab

The fields on this tab are a subset of the same tab on the Invoice Worksheet. See 
“Shipping Tab” on page 14-3.

Foreign Trade Tab

The fields on this tab are a subset of the same tab on the Invoice Worksheet. See 
“Foreign Trade Tab” on page 14-5.

Menu Buttons

The menu buttons on this window are a subset of the same buttons on the Purchase 
Order card. The Cr. Memo button is a subset of the options in the Order button.See 
“Invoice Worksheets” on page 14-1. The Navigate button brings up the navigate 
window as described in “Navigate” on page 23-2.

Registers

Registers are described in “Registers” on page 23-1.

Navigate

Navigate is described in “Navigate” on page 23-2.
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Chapter 16: Logistics and Planning
In This Chapter

• Items

• Requisition 
Worksheet

• Purchase 
Orders

• Purchase 
Receiving

• Shipment

• Customer 
Returns

• Return to 
Vendor

• Transfer 
Journals
The Logistics and Planning folder contains windows that allow 
you to track product from creation through shipping. The folder 
provides for specific project accounting scenarios where the 
product is already paid for and billed to the client, but it remains 
in the warehouse for tracking purposes at zero financial value 
until it is shipped to the client. Windows in this folder allow you 
set up item tracking and execute product tracking activities.

Once you setup items, the remaining windows are used in the 
Logistics and Planning product tracking activity process. The 
processing is:

1. Create Requisition Worksheets.

See “Requisition Worksheet” on page 16-4. This turns into a 
Purchase order. See “Purchase Orders” on page 16-7.

2. Receive the Purchase Order.

See “Purchase Orders” on page 16-7.
3. Ship the order.

See “Shipment” on page 16-8.
4. Receive returns.

See “Customer Returns” on page 16-12

5. Reship the item to the vendor.

See “Return to Vendor” on page 16-12
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Item

Logistics and Planning
Item

The Item windows allows you to setup product tracking. For government contractors, 
the primary focus for items are the General and Invoicing tabs. For all other tabs, refer to 
Navision Financial Management Inventory module documentation.

General 

The General tab allows you to enter basic information about the order. 

To enter information in the General tab:

1. Click the Logistics and Planning Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.

2. Click the Item Card.

The Item card appears in the display area.

3. Click the General tab.

The card is repopulated with general tab information.

4. Enter the item Number and description.

5. Select the item’s base unit of measure.

6. Enter the shelf number where the item is located.

7. If desired, check Automatic Ext. text.

8. Select the Item Category and Product Group codes.

Search Description, Quantity Information, and Service Item group are optional.
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Item
Logistics and Planning
Invoicing

The Invoicing tab allows you to provide information about invoicing the item.

To enter information in the Invoicing tab:

1. Click the Logistics and Planning Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.
2. Click the Item Card.

The Item card appears in the display area.

3. Click the Invoicing tab.

The card is repopulated with Invoicing tab information.

4. Select the Cost method.

5. Enter Unit cost and Last Direct Cost Information.

Enter unit cost or last direct cost.
6. Select Posting Groups.

7. Enter the tax group code.

8. Check Inventory Value zero.

This is required.
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Requisition Worksheet

Logistics and Planning
Requisition Worksheet

The Requisition Worksheet allows users who are not in Navision to generate 
requisitions via the web or Excel spreadsheet. Those worksheets are then imported into 
Navision as a basis for quotes and Purchase orders.

To create quotes from the requisition worksheet:

1. Click the Logistics and Planning Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.

2. Click the Requisition Worksheet.

The Requisition Worksheet Header appears in the display area.

3. Select Import Requisition from the Functions menu button.

4. Select Create RFQ from the Functions menu button.

5. Get approval on the RFQ.
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Requisition Worksheet
Logistics and Planning
6. Select Carry Out Action from the Function menu button.

The order is created as a quote and placed in the Purchasing section.

General Tab

The General tab allows you to enter basic information about the requisition. 

To enter information in the General tab:

1. Click the Logistics and Planning Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.

2. Click the Requisition Worksheet.

The Requisition Worksheet Header appears in the display area.

3. Click the General tab.

The window is repopulated with general tab information.

4. Enter the Requisition number and description.

5. Enter the Requestor number and Approved by information.

6. Check the box if this is a travel requisition.

7. Select the Request for Quote Vendor and Document information.

8. Check the Completed box if this requisition is completed.
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Requisition Worksheet

Logistics and Planning
Shipping Tab

The Shipping tab allows you to enter Shipping information for the requisition. 

To enter information in the Shipping tab:

1. Click the Logistics and Planning Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.
2. Click the Requisition Worksheet.

The Requisition Worksheet Header appears in the display area.

3. Click the Shipping tab.

The window is repopulated with Shipping tab information.

4. Enter ship-to information.

Line Menu Button

The line menu button is used to view the Item card.

To enter information in the Line Button:

1. Click the Logistics and Planning Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.
2. Click the Requisition Worksheet.

The Requisition Worksheet Header appears in the display area.

3. Click the Line menu button
16-6

User’s Manual



Purchase Orders
Logistics and Planning
A pull-down menu appears allowing you to select the desired function:

Functions Menu Button

The Function menu button provides important options for creating the requisition.

To invoke options from the Functions button:

1. Click the Logistics and Planning Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.

2. Click the Requisition Worksheet.

The Requisition Worksheet Header appears in the display area.
3. Click the Functions menu button

A pull-down menu appears allowing you to select the desired function:

Purchase Orders

The Purchase Order Card in Logistics and Planning creates orders from info generated 
in the Requisition worksheet and is exactly the same as the Purchase Order card in Order 
Processing. See “Purchase Order Card” on page 12-1. 

Menu Item Description

Card Invokes the Item card.

Item tracking 
Lines

Not used.

Item Availability 
by

Not used.

Menu Item Description

List Shows all requisition worksheets.

Calculate Plan Not used.

Drop Shipment Not used.

Special Order Not Used.

Carry Out Action 
Message

Generates the purchase order.

Reserve Not used.

Order Tracking Not used.

Create RFQ Creates Request for Quote.

Approve Batch Sends information to the approver.

Import Requisition Imports the requisition.
16-7
User’s Manual



Purchase Receiving

Logistics and Planning
Purchase Receiving

The Purchase Order receiving Card in Logistics and Planning receives items that were 
purchased and is exactly the same as the Order receiving Card in Order Processing. See 
“Order Receiving” on page 12-9.

Shipment

The Shipment card allows you to ship items that have been received.

General Tab

The General tab allows you to enter basic information about the order. 

To enter information in the General tab:

1. Click the Logistics and Planning Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.

2. Click the Shipment Card.

The Order Shipment card appears in the display area.
3. Click the General tab.

The card is repopulated with General tab information.

4. Enter the shipment Number.

5. Enter Sell-to information.

6. Enter Bill-to information.

7. If the Shipment is tax liable, check the box.

8. Enter Delivery date information.

9. Enter the salesperson, department and project codes.
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Shipment
Logistics and Planning
Shipping Tab

The Shipping tab allows you enter information to ship the order.

To enter information in the Shipping tab:

1. Click the Logistics and Planning Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.
2. Click the Shipment Card.

The Order Shipment card appears in the display area.

3. Click the Shipping tab

The card is repopulated with Shipping tab information.

4. Enter Ship-to information.

5. Enter the tax area codes.

6. Enter the Freight Amount.

7. Select the location Code.

8. Select the Shipping Method Code, Agent Code, and Agent Service code.

9. Check the box if Late Order Shipping is allowed.

10. Enter the Package Tracking Number.

11. Select Shipping Advice.
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Shipment

Logistics and Planning
Order Menu Button

The order button allows you to view information about the order.

To enter information in the Order Button:

1. Click the Logistics and Planning Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.
2. Click the Shipment Card.

The Order Shipment card appears in the display area.

3. Click the Order menu button.

A pull-down menu appears allowing you to select the desired function:

Line Menu Button

The Line menu button allows you to show dimensions.

To enter information in the Line Button:

1. Click the Logistics and Planning Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.

2. Click the Shipment Card.

The Order Shipment card appears in the display area.

3. Click the Line menu button

A pull-down menu appears allowing you to select the desired function:

Menu Item Description

List Shows all shipments.

Statistics View summary information.

Card Invokes the Customer card.

Comments Allows you to add comments.

Shipments Displays posted sales shipments.

Invoices Displays posted sales invoices.

Dimensions Displays default dimensions.

Order Promising Invokes the Order Promising window where you can 
calculate when you are available and capable of 
promising the order.

Menu Item Description

Dimensions Shows default dimensions.

Item Charge 
Assignment

Not used.

Item Tracking 
Lines

Not used.
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Shipment
Logistics and Planning
Functions Menu Button

The Function menu button allows you to set drop shipment and special order 
parameters.

To enter information in the Functions Button:

1. Click the Logistics and Planning Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.

2. Click the Shipment Card.

The Order Shipment card appears in the display area.

3. Click the Functions menu button

A pull-down menu appears allowing you to select the desired function:

Posting Menu Button

The Posting menu button allows you to record transactions.

To enter information in the Posting Button:

1. Click the Logistics and Planning Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.

2. Click the Shipment Card.

The Order Shipment card appears in the display area.
3. Click the Posting menu button.

A pull-down menu appears allowing you to select the desired function:

Menu Item Description

Drop Shipment Not used.

Special Order Not used.

Reopen Reopen a posted shipment.

Menu Item Description

Test Report The test report is Navision’s Edit report. The system 
prints out the entries from the time journal in a report. 
You can then review your work before you post the 
journal. Once the journal is posted you are not able to re-
run the test report. You can review error messages 
displayed in the test report and take appropriate action.

Post This option allows you to post the entries to the system. 
Once posting is completed, the system will clear the 
journal. Navision makes entries to the resource ledger, the 
project ledger, and the general ledger.

Post and Print This runs the same function, as the Post option, but it 
prints out a register report for you. 
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Customer Returns

Logistics and Planning
Customer Returns

This card is used when the customer returns items they have received. The card is 
identical to the Order Processing Sales Credit Memo Card. See “Credit Memo” on page 
14-8.

Return to Vendor

This card is used when you return items to the vendor. The card is identical to the Order 
Processing Purchasing Credit Memo Card. See “Credit Memos” on page 12-11.

Transfer Journals

The Transfer Journal is used to move items between locations or warehouses.

To access the Transfer Journal:

1. Click the Logistics and Planning Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.

2. Click Transfer Journal.

The Item Reclass Journal appears in the display area.

3. Modify rows as desired.

Line Menu Button

To enter information in the Line Button:

1. Click the Logistics and Planning Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.

2. Click the Transfer Journal.

The Transfer Journal appears in the display area.
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Transfer Journals
Logistics and Planning
3. Click the Line menu button.

A pull-down menu appears allowing you to select the desired function:

Item Menu Button

The item menu button displays related information.

To enter information in the Item Button:

1. Click the Logistics and Planning Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.

2. Click the Transfer Journal.

The Transfer Journal appears in the display area.

3. Click the Item menu button.

A pull-down menu appears allowing you to select the desired function:

Functions Menu Button

The Functions menu button allows to explode the BOM.

To enter information in the Functions Button:

1. Click the Logistics and Planning Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.

2. Click Transfer Journal.

The Transfer Journal appears in the display area.

3. Click the Functions menu button

A pull-down menu appears allowing you to select the desired function:

Menu Item Description

Dimensions Shows default dimensions.

Item tracking Lines Not used.

Bin Contents Not Used.

Menu Item Description

Card Invokes the Item card.

Ledger Entries Displays ledger entries.

Item Availability by Not used.

Menu Item Description

Explode BOM Explode the Bill of Materials.

Get Bin Content Not used.
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Transfer Journals

Logistics and Planning
Posting Menu Button

The Posting menu button allows you to record transactions.

To enter information in the Posting Button:

1. Click the Logistics and Planning Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.
2. Click the Transfer Journal Card.

The transfer Journal card appears in the display area.

3. Click the Posting menu button

A pull-down menu appears allowing you to select the desired function:

Menu Item Description

Test Report The test report is Navision’s Edit report. The system 
prints out the entries from the time journal in a report. 
You can then review your work before you post the 
journal. Once the journal is posted you are not able to re-
run the test report. You can review error messages 
displayed in the test report and take appropriate action.

Post This option allows you to post the entries to the system. 
Once posting is completed, the system will clear the 
journal. Navision makes entries to the resource ledger, the 
project ledger, and the general ledger.

Post and Print This runs the same function, as the Post option, but it 
prints out a register report for you. 
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Chapter 17: Logistics and Planning - History
In This Chapter

• Order 
Modifications

• Posted 
Receipts

• Posted 
Shipments
Logistics and Planning History allows you to review product 
tracking activities.

Order Modifications

This card is identical to the Order Processing Purchase History 
Order Modifications Card. See “Order Modifications” on page 
13-1.

Posted Receipts

This card is identical to the Order Processing Purchase History 
Card. See “Posted Receipts” on page 13-5.
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Posted Receipts

Logistics and Planning - History
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Chapter 18: Web Time and Expense
In This Chapter

• Web Projects

• Web Users

• Team

• Per Diem Rate

• Project Time 
Journals

• Expense Report

• Expense 
Invoice
Web Time and Expense allows easy entry, maintenance, 
management, and approval of employee time. 

Web Time and Expense automatically consolidates timesheets by 
project and client. 

Web Time and Expense relies on proper Project and Resource 
setup. Projects and Resources are imported and continually 
synchronized with web activities.

Items in this folder allow you to set up resources and projects for 
web use as well as execute periodic web activities.

Web Projects List

The Web Projects list allows you to import projects from the 
Project card and synchronize those projects with time entered on 
the web. 

To create Web Projects:

1. Click the Web Time & Expense Folder expansion symbol (+) in 
the tree.

The tree expands to reveal cards and three folders.

2. Click Web Projects.

The Web Projects list appears in the display area.

3. Select Synchronize from the Functions menu to update all 
projects.

4. As desired, select options from the Projects button.
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Web Users

Web Time and Expense
Project Button

The Project button has three options, Project Members, Categories, and Time Log.

To enter information from the Project button:

1. Click the Web Time & Expense Folder expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.
2. Click Web Projects.

The We Projects list appears in the display area.

3. Click the Project menu button

A pull-down menu appears allowing you to select the desired function:

Functions

The Functions button allows you to synchronize Navision and Web Time Entry. 
Projects, WBS, and labor categories are synchronized by this function.

To enter information from the Functions button:

1. Click the Web Time & Expense Folder expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.
2. Click Web Projects.

The Web Projects list appears in the display area.

3. Select Synchronize from the Functions menu to update all projects.

Web Users

The Web Users table is used to add, edit, and delete Web Users. Web users are gathered 
from the resources you created in the Resource card.

To create Web Users:

1. Click the Web Time & Expense Folder expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.
2. Click Web Users.

Option Description

Web Project Members This window is used to add and remove members from a project. The 
system default is to add all users within the same division to the project.

Web Project WBS Web Project WBS table is used to create project WBS codes for time 
entry. 

Time Log Entries The Time Log Entries table allows you view web time entries for 
projects.   This log filters on the project you highlight in the web 
projects window.
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Web Users
Web Time and Expense
The Web Users list appears in the display area.

3. Select Synchronize from the Functions menu to update all resources.

Resource information is imported and synchronized. You may also modify row 
information as desired:

4. As desired, select options from the Projects and Web Users buttons.

Note: If the users lose their password, the administrator can delete all characters in the field 
and press tab to reset the password.

Web User Button

The Web Users button allows you to view or add members to the project.

Field Description

ERP resource No. The resource number

Navision Vendor No. Navision’s vendor number.

Password This field is the password given to the user. A user who uses forms can 
modify his/her password from the Web Time Entry website. Not used 
for Windows Authentication.

Web Login Name Assigned login name for web entry.

Role ID Web user roles include: Administrator, Project Manager, Employee 
and Supervisor

Display Name The name displayed on the web.

Time Approver No. This number is used to determine who approves the time sheet. 

Time Approver Name The name of the time approver.

Alternate Time approver Here you enter the name of the time approver who approves time when 
the specified time approver is absent. The active time approver is the 
approver currently able to approve time.

E-Mail Address This field is you’s E-Mail Address, which is used to notify you and 
supervisor of status changes of the time sheet.

Value fields These fields allow you to enter specifc time-related information for 
each user. This information is often seen on time sheets. For example, 
holiday, vacation, sick, and comp-time.

Posting date The date time was posted.
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Web Users

Web Time and Expense
To enter information from the Functions button:

1. Click the Web Time & Expense Folder expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.

2. Click Web Users.

The Web Users list appears in the display area.

3. Click the Web Users menu button to add users to a specific project in Web Projects list.

Functions Menu Button

The Functions menu button allows you synchronize, set approvers, and update PTO 
accruals.

To enter information in the functions menu button:

1. Click the Web Time & Expense expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.

2. Click the Web Users list.

The Web Users list appears in the display area.
3. Click the Functions menu button.

A pull-down menu appears allowing you to select the desired function:

Option Description

Synchronize Import resources into projects.

Set Alt Time Approver Active Name alternate time approver.

Set Time Approver Active Name time approver.

Set Alt Exp Approver Active Name alternate expense approver.

Set Exp Approver Active Name expense approver

Update PTO Accruals Manually update PTO accruals. This is a recurring 
activity.
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Team
Web Time and Expense
Team

The team window allows you to add whole teams to projects instead of adding resources 
individually.

General Tab

The General tab allows you to set up your teams.

To setup your teams:

1. Click the Web Time & Expense expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.

2. Click the Team card.

The Team card appears in the display area.

3. Enter the team Code and Description

4. Select the Time approver and Alt time approver.

5. Select the Expense approver and alternate expense approver.

6. Enter Resource information in the table on the bottom left.

These are your web users. Use the lookup arrow to select users from the list.
7. Enter Project Information.

These are your web projects. Use the lookup arrow to select projects from the list.

8. Enter Indirect Code Information.

These are your Time posting groups. Use the lookup arrow to select codes from the list. 
For example, GA, overhead or holiday.

Resources/Web 
Users

Time Posting 
Groups

Projects/Web 
Projects
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Per Diem Rate

Web Time and Expense
Teams Tab

The Teams menu button allows you to view information about your teams.

To select options from the Teams pull-down:

1. Click the Web Time & Expense expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.
2. Click the Team card.

The Team card appears in the display area.

3. Click the Teams menu button

A pull-down menu appears allowing you to select the desired function:

Functions Menu Button

The function menu button allows you to take actions to synchronize and set up your 
teams. The import functions allow you to quickly populate a team for a group of users.

To enter information in the Functions Button:

1. Click the Web Time & Expense expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.

2. Click the Team card.

The Team card appears in the display area.
3. Click the Functions menu button.

A pull-down menu appears allowing you to select the desired function:

Per Diem Rate

PVBS populates this data. The per diem table includes CONUS Continental US and 
OCONUS outside of continental US.

Option Description

List Displays the project team list.

Web User List Displays the web user list.

Web Project List Displays the web project list.

Option Description

Synchronize Project membership Imports project member changes.

Synchronize Approvers Imports approver changes.

Import Web Users Imports existing web users/resources.

Import Web Projects Imports existing web projects.

Import Project Tasks Imports existing web project task orders.
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Web Time and Expense
Project Time Journals

A Project Time Journal is typically used for making time adjustments or importing time 
and exporting time from an external payroll system. The Project Time Journal option 
lets you make time entries and edit time journal entries. This window is identical to the 
Time Journal described in “Time Journal Activities” on page 10-1.

Expense Report

This expense report is available from approved expenses on the web. Use this to list 
approved expense reports and select the desired report for processing.

To view an expense report:

1. Click the Web Time & Expense expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.
2. Click Expense Report.

The Expense Report appears in the display area.

Expense button

To enter information in the Expense Button:

1. Click the Web Time & Expense expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.
2. Click Expense Report.

The Expense Report appears in the display area.

3. Click the Expense menu button.

A pull-down menu appears allowing you to select the desired function:

Expense Invoice

This window is identical to Order Processing Purchase Invoices. “Invoices” on page 12-
10.

Menu Item Description

List Displays the expense report list.

Create Purch. 
Invoice

Invokes Get Approved Expenses window. 
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Chapter 19: Web Time and Expense - Reports
In This Chapter

• Missing Time

• Employee 
Timesheet

• Expense Report
Web Time and Expense reports are used to monitor activities.

To run a report:

1. Click the Web Time & Expense expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.

2. Click the Reports expansion symbol (+) in the tree.

The tree expands to show three table windows.
3. Click the desired report.

The report’s table appears in the display area.
4. Click the first tab.

The window is repopulated with that tab’s information.

5. Enter data as described for each table.

6. Select desired options in the Options tab, if available, as 
described for each report.

7. Select Preview to view the report.

8. Select Print to print the report.

Missing Time

The Missing Time report is used to display time that has not been 
recorded in the Time Journal. Web time must be imported into 
the Time Journal prior to running the Missing Time report.

Resource Tab

The Resource tab allows you to select the desired resources for 
the report.

To enter information in the Resource tab:

1. Click the Web Time & Expense expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.
2. Click the Reports expansion symbol (+) in the tree.

The tree expands to show three table windows.

3. Click Missing Time.

The Missing Time table appears in the display area.

4. Click the Resource tab.
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Missing Time

Web Time and Expense - Reports
The window is repopulated with General tab information.

5. Select the Resource Number via lookup and enter the date filter.

Options Tab

The Options tab allows you enter dates and other options for generating the report.

To set report options:

1. Click the Web Time & Expense expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.
2. Click the Reports expansion symbol (+) in the tree.

The tree expands to three table windows.

3. Click Missing Time.

The Missing Time Entry table appears in the display area.
4. Click the Options tab.

The window is repopulated with Options tab information.

5. Check the Floor Check box if you want to view time on the web regardless of whether it 
was imported into the Time Journal.

6. Enter Time Starting Date and Floor Check Date.
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Employee Timesheet
Web Time and Expense - Reports
Employee Timesheet

The employee timesheet report allows you to view an employee’s timesheet.

Web User Tab

Select information about the web user.

To select the web user:

1. Click the Web Time & Expense expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.
2. Click the Reports expansion symbol (+) in the tree.

The tree expands to show three table windows.

3. Click Employee Timesheet.

The Employee Timesheet table appears in the display area.

4. Click the Web User tab.

The window is repopulated with Web User tab information.

5. Enter the employee resource number and division code.

Options Tab

The Options tab allows you to enter dates and other options for generating the report.

To select options:

1. Click the Web Time & Expense expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.

2. Click the Reports expansion symbol (+) in the tree.

The tree expands to three table windows.

3. Click Employee Timesheet.

The Employee Timesheet table appears in the display area.
4. Click the Web User tab.
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Expense Report

Web Time and Expense - Reports
The window is repopulated with Options tab information.

5. Select the Time Starting Date.

6. Check the desired options.

You can print a new page per employee, include an audit trail, and include comments.

Expense Report

The Expense Report displays an expense report for an employee.

To generate and report:

1. Click the Web Time & Expense expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.
2. Click the Reports expansion symbol (+) in the tree.

The tree expands to three table windows.

3. Click Expense Report.

The Expense report table appears in the display area.

4. Enter the report ID or Resource number.
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Chapter 20: Web Time and Expense - Setup
In This Chapter

• Web Time & 
Expense Card

• Web expense 
Codes

• Web 
Department
Web Time and Expense Setup allows you to setup web time 
related entries.

Web Time & Expense Setup

This window defines how people enter time and expenses via the 
web.

General Tab

The General tab defines basic information about T&E entry.

To enter information in the General tab.

1. Click the Web Time & Expense expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.

2. Click the Setup expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.
3. Click the Web Time & Expense card.

The Web Time & Expense setup card appears in the display area.

4. Click the General tab.

The card is repopulated with General tab information.

5. Select the enterprise resource planning (ERP) Company Code.

The number of the last expense report created is displayed. 

6. Check the e-mail box to indicate e-mail notification, if desired.
20-1



Web Time & Expense Setup

Web Time and Expense - Setup
7. Select the Holiday, Vacation, and Sick codes.

8. Select Compensated and unCompensated time codes.

9. Select the Pay Cycle view.

10. Enter the starting day of the cycle and the date.

Business Rules Tab

The Business Rules tab defines on which days to enforce minimum hours.

To enter information in the business rules tab.

1. Click the Web Time & Expense expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.
2. Click the Setup expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.

3. Click the Web Time & Expense card.

The Web Time & Expense card appears in the display area.

4. Click the Business Rules tab.

The card is repopulated with Business Rules tab information.

5. Check the Days to Enforce Minimum Hours.

6. Enter the Minimum Hours Required.

Requisitions Tab

The Requisitions tab defines the buyer.

To enter requisition information.

1. Click the Web Time & Expense expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.

2. Click the Setup expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.
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Web Expense Codes
Web Time and Expense - Setup
3. Click the Web Time & Expense card.

The Web Time & Expense card appears in the display area.

4. Click the Requisitions tab.

The card is repopulated with Requisitions tab information.

5. Select the Buyer Number, Finance Number, and Accounting Number.

Web Expense Codes

In this table, enter codes that drive expense reports. When the information is displayed 
on the web, it can be displayed using the expense report template, if that field is 
checked. The rate for mileage is entered in unit cost.
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Web Time and Expense - Setup
Web Department

In this table, enter the code and description for each web department.
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Chapter 21: Web Time and Expense - Periodic 
Activities
In This Chapter

• Get Approved 
Expenses

• Get Approved 
Time

• Reset

• Per Diem Rate
Web Time and Expense Periodic activities allows you to execute 
periodic activities via the web.

Get Approved Time

See “Time Journal Activities” on page 10-1.

Reset

Reset allows you to reset approved time. For instance, you can 
unapprove time. These functions cannot be performed via the 
web.

Time Entry Batch

Time entry batch resets time entry.

To reset time entry:

1. Click the Web Time & Expense expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.

2. Click the Periodic Activities expansion symbol (+) in the tree.

The tree expands to reveal cards and folders.
3. Click the Reset expansion symbol (+) in the tree.

The tree expands to reveal cards.
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Reset

Web Time and Expense - Periodic Activities
4. Click Time Entry Batch.

The Time Log Batch View appears in the display area.

5. Change the status for the employee as desired.

Expense Batch

Expense batch resets expenses.

To reset expenses:

1. Click the Web Time & Expense expansion symbol (+) in the tree.

The tree expands to reveal cards and three folders.
2. Click the Periodic Activities expansion symbol (+) in the tree.

The tree expands to reveal cards and folders.

3. Click the Reset expansion symbol (+) in the tree.

The tree expands to reveal cards.
4. Click Expense Batch.

The Expense Report List appears in the display area.

5. Change the status for the report as desired.
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Per Diem Rate
Web Time and Expense - Periodic Activities
Per Diem Rate

This option allows you to import the per diem rate into the web time table.
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Chapter 22: Generating Reports
In This Chapter

• All Reports
A report in Navision is an extract of information from the 
database. There are a large number of standard project reports, 
but you can use the built-in report designer to define new reports 
or change the standard project reports. Reports are generated to 
monitor activities.

Reports are very flexible. The items in the Options tab can be 
turned on and off to customize your reports.

To set up reports

1. Click the Reports expansion symbol (+) in the tree.

The tree expands to reveal cards 
2. Select the desired report.

3. Enter information in the Project tab.

4. Enter Information in the Options tab where available.

The options tab contains ways of customizing the report.
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Report Descriptions

Generating Reports
Report Descriptions

The following table describes each report.

Report Name Description

Project Setup Used to provide information about the project.

Cash Applied Report Shows cash applied by project. An example is the audit report which is 
used to provide a history by project of cash provided.

Aged Project Receivable Used to provide information that can be filtered by project.

Project Funding Notification Used to determine which accounts have exceeded the funding percent 
that you specify on the options tab.

Project Detail with Billing Used to generate backlog reports which show inception date, revenue, 
billing, and unbilled amounts.

Project Revenue Summary Shows by project inception date year-to-date, current revenue, and 
backlog.

Project Status Report Shows project profitably on current period, year-to-date and inception 
to date.

Labor Utilization by 
Employee

Shows the amount of time charged direct vs. indirect by employee

Labor Summary By category Shows the amount of time charged direct vs. indirect by category

Labor Utilization Trend Shows trend by month.

Missing Time See web reports. See “Missing Time” on page 19-1.

Employee Roster Shows list of employees.

Employee Timesheet See web reports “Employee Timesheet” on page 19-3.

Contract Revenue Trend Compares revenue with prior month, current period, and year-to-date.

Project Actual to WBS 
Budget (Cost)

Compares actual cost at the WBS budget level for cost.

Project Actual to WBS 
Budget (Price)

Compares actual price at the WBS budget level for price.

Project WBS Budget Shows the project budget.

Outstanding Purch. Ord. by 
Project

Shows outstanding purchase orders filtered by project.

Unbilled Analysis Shows the unbilled amount by task and by project.

Job Cost Transaction Detail Shows detailed costs for a project.

Job List Lists projects with status and customer.

Job on Order Lists jobs with the status Order.

Job Register Shows a list of transactions for a particular register.
22-2

User’s Manual



Chapter 23: History
In This Chapter

• Registers

• Navigate
The items in the History folder allow you to review activities.

Note: The Functions button is not used.

Registers

Registers are records of postings. They tell you when the ledger 
was updated and by whom. You can view detailed information on 
entries in four ledgers: general ledger, customer ledger, vendor 
ledger, and project ledger.

To access registers:

1. Click the History Folder expansion symbol (+) in the tree.

The tree expands to reveal cards.
2. Click Registers.

The Projects Registers list appears in the display area. You see all 
the transactions that were entered in that journal entry. 

3. Click the Register Button and select the desired ledger.

This information is helpful for internal research or external 
accounting purposes. Please note that if you need a print out of 
the register you have to run the report called G/L register. Enter 
the register number and the system prints the entries for that 
register.
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History
Navigate

The Navigate feature in Navision is a way to see a summary of the number and type of 
entries with the same document number and date. For example, with an invoice number, 
you can view every entry related to that invoice.

The Navigate window is accessible through tree selection or by selecting a Navigate 
button.

General Tab

The General tab allows you to find items by document number or posting date. The 
window lists the document type, and the source type, number, and name. On the lower 
portion, there is a list of all tables where that document number has entries, such as the 
General Ledger Entry table or the Posted Purchase Invoice table.

To locate related items:

1. Click the History Folder expansion symbol (+) in the tree.

The tree expands to reveal cards.

2. Click Navigate.

3. Click the General tab.

The General tab appears.

4. Enter the document number or posting date 

5. Click Find.

The remainder of the window is populated with the found information.
23-2

User’s Manual



Navigate
History
External Tab

The External tab allows you to find items by document number or posting date. You 
may use the External tab to navigate by an external document number such as a Vendor 
Invoice number.

To locate related items:

1. Click the History Folder expansion symbol (+) in the tree.

The tree expands to reveal cards.

2. Click Navigate.

3. Click the External tab.

The External tab appears.

4. Enter the Business Contact type, Business Contact No., or Document number

5. Click Find.

The remainder of the window is populated with the found information.
23-3
User’s Manual



Navigate

History
23-4

User’s Manual



Chapter 24: Periodic Activities
In This Chapter

• Recurring 
Journals

• Allocate Costs

• Calculate 
Maximum 
Hours

• Calculate and 
Post Fee

• WIP/Recognize 
Revenue

• Recognize Un-
billed Method
Periodic Activities are executed at required or requested 
intervals.

Recurring Journals

This window is used to create billed schedules for Fixed Price 
projects. 

To enter information in the Recurring Journal:

1. Click the Periodic Activities Folder expansion symbol (+) in the 
tree.

The tree expands to reveal cards and folders.
2. Click the Recurring Journals card.

The card appears in the display window.

3. Enter a batch name.
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Recurring Journals

Periodic Activities
4. Add, Delete, or Modify table rows.

Line Menu Button

The line menu button shows dimensions.

Job Menu Button

Not used.

Functions Menu Button

Not used.

Field Description

Recurring method Fixed is the amount on the journal line that remains 
after posting. Variable is the amount on the journal 
line that is deleted after posting.

Recurring 
frequency

Determines how often the entry on the journal line is 
posted. The field must be filled in. For example, if the 
journal has to be posted every month, enter 1M. After 
every posting, the date in the Posting Date field is 
updated to the same date in the following month. The 
codes for recurring frequencies are: D (day), W 
(week), M (month), Q (quarter), Y (year),

Posting Date The date you assign to the billing.

Document No. The document number you assign to the billing.

Project No. The Project No. you are billing.

Type In this field, you enter an account type for project 
usage to be posted in the project journal. To see the 
types that are available, click the Assist Button to the 
right of the field. 

No. Field Select the resource, item, or G/L account number to 
which this entry applies. The No. must correspond to 
your selection in the Type field. Click the Assist 
Button to the right of the field to see the Resource List 
table.

Quantity Here you can enter the quantity of units that you intend 
to post.

Unit of Measure In this field, you enter a unit of measure for the 
project.

Unit Price This field is automatically filled in with the unit costs 
of the selected Type and No. In the case of a G/L 
account, the field must be filled in manually.

Total Price The program calculates the amount as Quantity * Unit 
Price. If you change one of these fields, the entry in the 
Total Price field is changed accordingly.
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Allocate Costs
Periodic Activities
Posting Menu Button

The Posting menu button allows you to record transactions.

To enter Posting menu button information:

1. Click the Periodic Activities Folder expansion symbol (+) in the tree.

The tree expands to reveal cards and folders.
2. Click the Recurring Journals card.

The card appears in the display window

3. Click the Posting menu button.

A pull-down menu appears allowing you to select the desired function:

Allocate Costs

The Allocate Costs routine is run at month end to allocate cost such as fringe, overhead, 
and G&A to projects. This routine should be run after all cost has been entered into 
Navision for the month. Enter the desired options and click OK.

Menu Item Description

Test Report The test report is Navision’s Edit report. The system 
prints out the entries in a report. You can then review 
your work before you post the journal. Once the journal is 
posted you are not able to re-run the test report. You can 
review error messages displayed in the test report and 
take appropriate action.

Post This option allows you to post the entries to the system. 
Once posting is completed, the system will clear the 
journal. Navision makes entries to the resource ledger, the 
project ledger, and the general ledger.

Post and Print This runs the same function, as the Post option, but it 
prints out a register report for you. 

Reconcile You can see the change in accounts that are set up for 
reconciliation. (GL setup) The system displays the net 
change and the balance after posting.
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Calculate Maximum Hours

Periodic Activities
Calculate Maximum Hours

This functionality is used to calculate maximum hours on a project where maximum is 
checked on the pricing schedule for a project. It creates project journal lines that can be 
reviewed and posted. Enter the desired options and click OK.

Calculate and Post Fee

This routine calculates and posts fee. The routine can be run by project or for all 
projects. You must run the cost allocation routine before you calculate and post fee. 
Enter the desired options and click OK.
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WIP/ Recognize Revenue
Periodic Activities
WIP/ Recognize Revenue

This folder contains items that track the movement of cost between the balance sheet 
and income statement based on timing differences for revenue recognition.

Calculate Project WIP Value

This batch process prepares the entries in the Project Ledger Entry table for posting to 
the corresponding general ledger accounts. This batch process must be executed before 
you run the Post Project WIP Value to G/L batch process.

The Amt. to Post to G/L field is changed to the value to be posted to the general ledger. 
If the Entry Type is Usage, the batch process enters the amount shown in the Total Cost, 
in this field. If the entry type is Sale, the amount to be posted to the general ledger is 
equal to the total price. 

You can define what is included in the batch process by setting filters. You can set 
additional fields on the tab by clicking the field, then clicking the Assist Button that 
appears to the right. 

To calculate Project WIP Value:

1. Click the Periodic Activity Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.
2. Click the expansion symbol for WIP/Recognize.

A list of windows is displayed.
3. Click Calculate Project WIP Value.

The window appears in the display area.

4. Enter information on the Project tab.

Here you can specify the numbers of the projects to be included in the batch process. To 
see the existing project numbers, click the Filter field, then click the Assist Button that 
appears to the right.
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WIP/ Recognize Revenue

Periodic Activities
5. Enter Information on the Project Ledger Entry tab.

In Entry Type, you can determine whether to post usage or sale to the general ledger 
accounts. If you leave the field blank, both kinds of entries are posted.

In Posting Date, you can select a certain posting date or a period during which entries 
have been posted. It is possible to enter a date or a time interval.

6. Click OK.

Post Project WIP Value to G/L

You must calculate Project WIP Value before posting. This batch process posts the Amt. 
to Recognize in the Project Ledger Entry table to the corresponding general ledger 
accounts. After finishing the batch process, the Amt. Recognized field in the Project 
Ledger Entry table is filled with the posted amounts.

This requires that the Calculate Project Recognition batch process has been completed. 

To Post Project WIP Value to G/L:

1. Click the Periodic Activity Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.
2. Click the expansion symbol for the WIP/Recognize.

A list of windows is displayed.
3. Click Calculate Project WIP Value.

The window appears in the display area.

4. Enter information on the Project tab.
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WIP/ Recognize Revenue
Periodic Activities
The option chosen in the Recognition Method field on the Project card permits you to 
perform the deactivation of project ledger entries. In the recognition method on the 
Project card, there are two possibilities: Percentage of Completion and Completed 
Contract. Completed Contract allows recognition only when the status is completed. 
Percentage of Completion permits continuous deactivation.

5. Enter Information in the Project Ledger Entry tab.

There are two types of project ledger entries: Usage and Sale. The valuation of the 
project's usage is determined in the Project Usage Posting field. You can choose to post 
the project usage either as unit prices or as unit costs to the general ledger accounts. 

6. Enter Information in the Options tab.

7. If Desired, click the Print button to print out the batch process. 

If you want to see the batch process on the screen before printing, click the Preview 
button. Click the up-arrow in the lower left-hand corner to see the results of the filter 
you have defined for the table. 

Menu Item Description

Posting Date Enter the date on which the project recognition is posted to the general ledger.

Document No. In this field, you should enter a document number for the entire posting process. 
Later you are able to track the posting with the help of the Navigate function.

Posting 
Description

This field contains as a default value the text: Posting%1 for Project Posting 
Group%2. Upon posting the text, %1, is replaced with the entry type and the text, 
%2, is replaced with the corresponding project post group. The contents can be 
modified.

Post Place a check mark in this field if you want the program to post to the general 
ledger automatically. If you do not choose to post the Project Recognition to G/L, 
the batch process only prints a test report, and on the report appears: Test Report 
(not posted).
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Recognize Un-billed Method

Periodic Activities
Calculate Project Recognition

This batch process prepares the entries in the Project Ledger Entry table for posting to 
the corresponding general ledger accounts. This batch process must be executed before 
you run the Post Project Recognition to G/L batch process.

To calculate project recognition:

1. Click the Periodic Activity Folder expansion symbol (+) in the tree.

The tree expands to reveal two folders.

2. Click the expansion symbol for the WIP/Recognize.

A list of windows is displayed.
3. Click Calculate Project Recognition Value.

The window appears in the display area.

4. Enter information on the Project tab.

5. Enter information in the Project Ledger Entry tab.

The Amt. to Recognize field in the Project Ledger Entry is changed to the value to be 
posted to the general ledger. If the Entry Type is Sale, the batch process enters the equal 
amount as the Total Price in this field. If the entry type is Usage, the amount to be posted 
to the general ledger depends on the Project Usage Posting field.

6. Click OK.

Post Project Recognition to G/L

You must calculate Project Recognition before posting. This window is identical to the 
Post Project WIP to G/L window. See “Post Project WIP Value to G/L” on page 24-6.

Recognition Percentage

Not used.

Recognize Un-billed Method

This group contains windows that help you move revenue.

Calculate Cost Plus Revenue 

This batch function prepares the entries in the Project Ledger Entry table for posting to 
the corresponding general ledger accounts. This batch process must be executed, before 
you run the CPFF recognition to G/L batch process.

You can define what is included in the batch process by setting filters. You can set 
additional fields on the tab by clicking the field, then clicking the Assist Button that 
appears to the right.
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Recognize Un-billed Method
Periodic Activities
This window is identical to the Calculate Project WIP Value window. See “Calculate 
Project WIP Value” on page 24-5 for details.

Post Cost Plus Project Recognition to GL

You must calculate Cost plus revenue before posting. This batch process posts the Amt. 
to Recognize in the Project Ledger Entry table to the corresponding general ledger 
accounts.

This requires that the CPFF Project Revenue batch has been completed.

The option chosen in the Recognition Method field on the Project card permits you to 
perform the deactivation of project ledger entries. In the recognition method on the 
Project card, there are two possibilities: Percentage of Completion and Completed 
Contract. Completed Contract allows recognition only when the status is completed. 
Percentage of Completion permits continuous deactivation.

You must calculate T&M Revenue before posting. This window is identical to the Post 
Project WIP to G/L window. See “Post Project WIP Value to G/L” on page 24-6.

Calculate Fixed Price Revenue

This window is identical to the Calculate Project WIP Value window with the addition 
of the Options tab. See “Calculate Project WIP Value” on page 24-5 for details. The 
Options tab allows you to enter the type of tasks to recognize. 

Post Fixed Price Recognition to G/L

You must calculate Fixed Price Revenue before posting. This window is identical to the 
Post Project WIP to G/L window with the addition of the type of tasks to recognize 
option. See “Post Project WIP Value to G/L” on page 24-6.

Calculate TM Project Revenue

This window is identical to the Calculate Project WIP Value window. See “Calculate 
Project WIP Value” on page 24-5 for details. 

Post TM Project Recognition to GL

You must calculate T&M Revenue before posting. This window is identical to the Post 
Project WIP to G/L window. See “Post Project WIP Value to G/L” on page 24-6.
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Chapter 25: Setup
In This Chapter

• Projects

• Government 
Contractor

• Cost pool Setup 

• Resources

• Time Posting 
Groups

• Posting Groups

• ADP 
Deductions

• Phases, tasks, 
Steps

• Journal 
Templates

• Reporting 
Forms

• Sales Invoices
The Setup folder includes various tables that are used to 
configure Navision for government contracting.

Initial setup for these items is performed by PVBS.

Projects Setup

The Projects Setup card is used to determine how the system 
handles cost.

Note: This window is setup by PVBS, but may need minor modification 
at times.

To enter information on the Projects Setup Card:

1. Click the Setup Folder expansion symbol (+) in the tree.

The tree expands to reveal cards.
2. Click Projects Setup.

The card appears in the display area.

3. Select the Project No.

Enter the code for the number that is used to assign numbers to 
projects. 

4. Enter WIP Information.

WIP Time & Materials check box tells the system to WIP Time & 
Materials projects.

WIP Firm Fixed Price check box tells the system to WIP Firm 
Fixed Price projects.

WIP Cost Plus Fixed Fee check box tells the system to WIP Cost 
Plus Fixed Fee projects.
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Government Contractor Setup

Setup
In Entry Type WIP Filter you can specify whether to post expenses or revenue to the 
general ledger balance sheet accounts. If you enter both, both kinds of entries are posted.

Select the Default Template Name and Default Batch Name.

Government Contractor Setup

The Government Contractor Setup window allows you to specify information that drives 
the project accounting module.

Note: This window is setup by PVBS, but may need minor modification at times.

General Tab

The General tab allows you to specify basic information about project accounting 
module.

To enter information on the General tab:

1. Click the Setup Folder expansion symbol (+) in the tree.

The tree expands to reveal cards.
2. Click Govt Contractor Setup.

The card appears in the display area.

3. Click the General tab.

The window is repopulated.

4. Enter Allocation and Fee Nos.

The Allocation Nos number series is used to manage numbering of cost allocation 
journals.
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Fee Nos. number series is used to manage numbering of fee journals.

5. Enter Dimension information.

The Cost Pool Code is used to define the dimension that is used to allocate costs such as 
Departments or Divisions.

The Project Code is used to define the dimension that is used to allocate costs to 
projects.

6. Enter Work Breakdown Structure information.

PVBS populates this section. This setup maps Task Orders to a dimension for G/L 
purposes.   There are no limitations on the number of activities. You do not have to use 
all three kinds of activities for every project. They are options that provide flexibility.

Task Code is used to define the dimension for tasks. Tasks are sub-activities in a phase.

WBS Mandatory field is required and used to define WBS Mandatory system wide. 

7. Enter remaining contractor information.

The G&A Pool Sequence field defines the sequence to be used by the system to 
determine the GA Allocation on projects revenue and profit calculation.

Check Allocate below task Order level to allocate indirect cost to WBS levels below the 
task order level.

Accounts Tab

This tab is used to provide general ledger account numbers for billing and allocation of 
cost to projects. 

To enter information on the Accounts tab:

1. Click the Setup Folder expansion symbol (+) in the tree.

The tree expands to reveal cards.
2. Click Govt Contractor Setup.

The card appears in the display area.
3. Click the Accounts tab.
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The window is repopulated.

4. Enter Home Based Fringe information.

For Fringe Account No. enter the G/L account for allocations to projects. This account 
can be a G/L account or statistical account.

For Fringe Contra Account No. enter the contra G/L account for allocations to projects. 
This account can be a G/L account or statistical account.

5. Enter Time Journal information.

Time Journal is used to provide information for account number for wages payable and 
hours per pay period.

In Wages payable Account No., enter the G/L account number that the labor journal 
posts wages payable.

Hours per pay period is the deafult numbers of hours per pay cycle. The value in this 
field is used to calculate the hourly rate for salaried employees for total time accounting.

6. Enter remaining account information.

Withholding Account No is the general ledger account number used for withholding 
from billings to clients.

Direct Labor Account Filter is used to tell the system the range of G/L accounts that are 
used to define direct labor.

Other Direct Cost Filter is used to tell the system the range of G/L accounts that are used 
to define other direct cost. This includes the entire range of other direct costs.

Sub Contractor Account Filter is used to tell the system the G/L account that is used to 
define Sub Contractor cost.

Revenue Account Filter is used to tell the system range of G/L accounts that is used to 
define revenue. It is primarily used on reports that show the budgeted revenue.

Select costs that are not billable in the UnAllowable Direct Cost Filter.
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Purchasing Tab

To enter information on the Purchasing tab:

1. Click the Setup Folder expansion symbol (+) in the tree.

The tree expands to reveal cards.

2. Click Govt Contractor Setup.

The card appears in the display area.

3. Click the Purchasing tab.

The window is repopulated.

4. Enter Purchase Requisition information.

5. Enter Logistics information.

This information enables logistics setting as specified in Logistics and Planning 
“Logistics and Planning” on page 16-1.

6. Enter Requisition Information.

7. Check P.O. Modification Tracking if tracking is desired.
25-5
User’s Manual



Cost Pool Setup

Setup
Cost Pool Setup

The Cost Pool Setup table is used to define the various cost pools and the sequence for 
allocating cost. This table also defines which pools allocate to projects. In addition, this 
table defines if and when B&P cost is moved to G&A.

Note: This window is setup by PVBS, but may need minor modification at times.

To enter information on the Cost Pool Card:

1. Click the Setup Folder expansion symbol (+) in the tree.

The tree expands to reveal cards.
2. Click Cost Pool Setup.

The card appears in the display area.

3. Insert, Delete, or Modify Rows.

Field Description

Sequence This field provides the order in which cost pools generates allocations.

Tier This field represents tier of the allocation. The example below tier 0 is 
Fringe while Tier 2 G&A allocation to projects.

Pool Code Enter a code for the cost pool. 

Description Here you can enter a short description of the Cost Pool. You can enter a 
maximum of 50 characters, both numbers and letters.

Allocation offset GL 
Account

You enter the GL account offset number in this field. The GL offset is used 
to tell the system where to record the contra amount to the allocation entry.   
The offset is used when cost is not being allocated to projects.

Project Account No This field is used to identify the account used to allocate actual cost to 
projects.

Project Contra Account 
No

This field is used to identify the account number used to record the contra 
amount for actual cost to projects. This ensures the allocation has a zero 
impact on net income.

Project Provisional 
Account No

This field is used to identify the account number used to allocate 
provisional cost to projects.

Project Provisional Contra 
Account No

This field is used to identify the account number used to record the 
contract amount for provisional cost to projects.
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Functions 

This button has three options that are used to set the rate calculation, allocation and 
provisional rate setups.

To enter information in the Functions button:

1. Click the Setup Folder expansion symbol (+) in the tree.

The tree expands to reveal cards.

2. Click Cost Pool Setup.

The card appears in the display area.

3. Click the Functions button.

A pull-down appears allowing you to select the desired function:.
4. Select the desired option. Each option’s details are summarized below:

Cost Pool Rate Calculation

Allocation Setup

The allocation functionality is used to move indirect cost to intermediate pools and 
finally to projects. This functionality is very flexible, designed to meet demanding 
requirements of growing companies. The allocation setup drives cost allocations and 
billing of indirect costs.     

Move B&P, IR&D costs to 
G&A

Enter a check at cost pool that B&P should be moved to G&A.

B&P, IR &D Overhead 
Contra Account

Enter an account in this field when a different overhead account is used 
other than the B&P Reversing Account setup in the Posting Groups. Also 
see B&P Posting Groups.

Field Description

Field Description

Numerator Check this column to indicate that this row is the numerator in the cost 
pool rate calculation.

G/L Account Filter This field defines the range of G/L accounts to be used in the cost pool 
rate calculation.

Cost Pool Dimension 
Filter

This field is used to define the department to filter on for the cost pool rate 
calculation.

Project Dimension Filter This field is used to define the project to filter on for the cost pool rate 
calculation.

Company Filter This field is used to define the company to filter on for the cost pool rate 
calculation. The feature is used in multi-company situations where costs 
are allocation to other companies.

Currency Code This field is used to define the currency for the cost pool rate calculation 
allocation to the company receiving the allocation.
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The monthly allocation process does not impact billing of cost plus projects. The billing 
functionality uses provisional rates when project setup is set at provisional rate for 
billing. 

The allocation setup table is used to define the distribution of cost to various pools and 
ultimately to projects. It is extremely important that the range of account in the 
allocation setup match the accounts in the denominator of the rate calculation.

Cost Pool Provisional Rates

Cost Pool Provisional Rates are negotiated indirect rates that are used by billing CPFF 
projects. This table is used to define how the indirect rate is calculated. The denominator 
is often called the base in Government Contractor terminology.

The Provisional rate pool defines the rate for allocating provisional cost to projects. In 
addition, Cost Pool Provisional Rates are negotiated indirect rates that are used for 
billing by some CPFF projects. These rates are date sensitive. The Start Date is the date 
the provisional rate is effective. One day before the new start date is end of the previous 
provisional rate. Rate is the provisional rate. The number format 110.00 represents 
110%.

Field Description

Start Date The Start Date is the date the provisional rate is effective. One day before 
the new start date is end of the previous provisional rate.

Rate This is the provisional rate. The number format 110.00 represents 110%.

Numerator Check this column to indicate that this row is the numerator in the cost pool 
rate calculation.

G/L Account Filter This field defines the range of G/L accounts to be used in the cost pool rate 
calculation.

Cost Pool Dimension 
Filter

This field is used to define the department to filter on for the cost pool rate 
calculation.

Project Dimension Filter This field is used to define the project to filter on for the cost pool rate 
calculation.

Company Filter This field is used to define the company to filter on for the cost pool rate 
calculation. The feature is used in multi-company situations where costs 
are allocation to other companies.

Currency Code This field is used to define the common currency for the cost pool rate 
calculation allocation to the company receiving the allocation.
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Resources Setup

The Resources setup manages how web time and expense interacts with the project 
ledger. 

Note: This window is setup by PVBS, but may need minor modification at times.

To enter information on the Resources setup card:

1. Click the Setup Folder expansion symbol (+) in the tree.

The tree expands to reveal cards.

2. Click Resources Setup.

The card appears in the display area.

3. Enter Resource Number, Week Staring Date, and Pay cycle.

Week Starting Day field assigns a week starting day for payroll processing.

Pay Cycle tells the system the frequency of your payroll cycle. The choices are weekly, 
Bi-monthly and every two weeks.

4. Enter Default Information.

You can setup the default e-mail domain and format for web users, the default program 
manager for web projects, and the default supervisor for web users. Enter the web 
application method and the default Windows domain. you can select a default Journal 
template and default batch name.

5. Enter the Paydata Visibility password.

6. If desired, check the Overtime Using half time rules box.

7. Enter ADP Information.

This section of the window is used to provide setup codes to import and export payroll 
data to ADP.

Company Code is the company code used by ADP import.

Regular hrs Field name is used by ADP import.

O/T hrs Field name is used by ADP import.

8. Enter Import Information.
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Enter the starting row used by ADP to import.

Enter the Resource column number used by ADP to import Resources.

Enter the Regular earning column number used by ADP to import Regular earnings.

Time Posting Groups

In this window, you must set up time posting group codes for labor types for posting 
purposes. The time posting groups are set up to map various labor & payroll types to 
appropriate G/L account numbers and external payroll service codes. 

Note: This window is setup by PVBS, but may need minor modification at times.

To enter information on the Time Posting Groups card:

1. Click the Setup Folder expansion symbol (+) in the tree.

The tree expands to reveal cards.
2. Click Time Posting Groups Setup.

The card appears in the display area.

3. Insert, Delete, or Modify Rows.

Field Description

Code This field is the code used to define the time posting.

Dept Code Department code.

Exclude from O/T 
Calculation

Costs for labor account are not included in OT calculation.

Rounding Rounding specification.

Description This field is the description of the time posting line.

G/L Account No. This field is the G/L Account No. used for this posting line.

Default This field defines the default time posting line. It is used in conjunction 
with project type field.

Project Type Project type is blank, IR&D or B&P. This field is used to have the system 
translate project time to the appropriate G/L account.

O/T This field is checked if overtime is calculated on the time posting Code. 
This field is used by the system to post O/T amount to the G/L.
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Posting Groups

Project Posting Groups are used to define the billing and revenue recognition general 
ledger accounts. Cost for B&P and IR&D projects are often accumulated as direct cost 
and moved to G&A. A combination of General Posting and Project Posting groups 
allow you to define the accounts for accumulating BP cost and moving this cost to 
G&A.

Note: This window is setup by PVBS, but may need minor modification at times.

To enter information on the Posting Groups Card:

1. Click the Setup Folder expansion symbol (+) in the tree.

The tree expands to reveal cards.

2. Click Posting Group Setup.

The card appears in the display area.

ADP Hrs Code Field 
Name

For companies that use ADP, the hours Code Field Name is used to 
provide ADP the field names for special time types such as sick time or   
vacation.

ADP Hrs Amount Field 
Name

For companies that use ADP, the Hours Amount Field Name is used by 
the system to provide ADP Hours Amount Field Name for special time 
types such as sick time or vacation.

ADP Code Valid for Primarily for indirect costs. Controls whether the entry is only posted to G/
L ledger or to labor calc. Prevents the entry from being counted against 
time ledger.

Add to Web Add selected time posting group to the web.

Field Description
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3. Insert, Delete, or Modify Rows.

ADP Deduction Setup

This setup is performed by PVBS.

To enter information on the ADP Deduction Setup Card:

1. Click the Setup Folder expansion symbol (+) in the tree.

The tree expands to reveal cards.

2. Click ADP Deduction Setup.

The card appears in the display area.

3. Insert, Delete, or Modify rows.

Phases, Tasks, and Steps

No setup is required for these items.

Menu Item Description

General Product Posting 
Group

In addition to setting up the necessary business group codes, you must also 
set up the necessary product group codes. For each combination, you must 
specify the information and relevant accounts that you want the program 
to use. The BP General Posting Group defines which account is used to 
create the contra to direct costs and the G&A account to record the 
movement

B&P- IR&D G/L 
Accounts 

This field is used by the system to determine the G/L account for reversing 
B&P and IR&D projects. The system uses the setups in the general posting 
setup table.

WIP Expenses Account Enter the G/L account for which you would like WIP expenses to be 
charged.

Revenue Offset (Un-
billed) Account 

Enter the G/L account for which you would like un-billed revenues to be 
charged.

Revenue Recognition 
Account

Enter the G/L account for which you would like Revenue recognition to be 
charged.

G/L Exp. Sales Account Enter the G/L account for when billing entries are posted to the project 
using a G/L Code.
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Journal Templates

The Journal Template table lets you set up special information that can be used in the 
journal lines. In a project journal template, the following elements can be assigned to the 
journal lines:

• Source Code 
• Reason Code
• Form ID
• Test Report ID
• Posting Report ID
• Recurring (yes or no)
• Force a posting report (yes or no)

No setup is required for this item.

Reporting Forms

The reporting forms setup for special reports such as government invoices, DD250s, and 
standard form 1035.

No setup is required for this item.

Creating Sales Invoices using Excel 

Because there are many differing formats that have been created, outside of accounting 
systems, the need exists for the ability to creating invoices in Excel from Navision 
generated data. The process involves creating generic templates for exporting of data 
and worksheets that converts the data into the desired format.

A number of datasets, (templates) that can be used by all that require formatting which 
differs from the standard navision reports have been created. The need may arise for 
additional datasets. 

Creating Excel Datasets

You can define the type of data to export to Excel worksheets.

To create Excel Datasets:

1. Click the Setup Folder expansion symbol (+) in the tree.

The tree expands to reveal cards.
2. Click Excel Dataset Card.
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Creating Sales Invoices using Excel 

Setup
The card appears in the display area.

3. Press F3 to create a new Dataset.

4. Assign a Code that helps describe that Dataset to be created. 

5. Describe the Dataset.

6. Determine the Table to use for pulling for the Data for creating of the Rows for the 
Export. 

7. Optionally, select a field from the table that you wish to place in column 1 in your Excel 
Spreadsheet.

8. Select a sort method.

9. Set Row Filters using the Dataset Menu button Row Filters option.

10. Insert rows in the Columns Table at the bottom of the screen to indicate which columns 
to export.

11. Select fields in the table rows and set Column Filters via the Column menu button 
Column Filters Option. 

 Creating Excel Worksheets

Now that you have determined what you are exporting, you need to determine the format 
in which the dataset is displayed. 

To create Excel Worksheets:

1. Click the Setup Folder expansion symbol (+) in the tree.

The tree expands to reveal cards.

2. Click Excel Worksheet Card.
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The card appears in the display area.

3. Press F3 to create a new Worksheet.

4. Assign a Code that helps describe that worksheet that is created. 

5. Describe the worksheet.

6. Select the Project No. for the Data to be Exported.

7. Enter a Folder name for the results.

8. Add rows to the table at the bottom of window.

9. Import the Excel file that is updated in the Invoice template. 

10. Select Print, Select Workbook to print and the Date range for Current Period.

This results in a Worksheet in your Spreadsheet with Resource Data.
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Appendix A: Shortcut Keys
Although pull-down menus are provided throughout the system, using ShortCut keys 
makes using Microsoft Navision faster and easier.

Function Hot Key

Find - Ctrl+F

Card to List - Search for information from 
a list of contents

F5

List to Card Shift+F5

Ledger Entries - View a list of general 
ledger entries

Ctrl+F5

Statistics F9

Look Up - Search for information from a 
list of valid entries

F6

Drill Down - Search for related 
background information

F6

Option List - Look up available options for 
a field

F6

Sort Shift+F8

Post F11

Post & Print Shift+F11

Next Window Ctrl+F6

Main Menu F12

Toggle Mark Ctrl+F1

Show Marked Only Alt+V, M

Next Record PageDown

Previous Record PageUp

Open Company Record Ctrl+O

Edit F2

Insert F3

Delete F4

Copy Ctrl+C

Paste Ctrl+V

Copy from above F8

Field Filter F7

Table Filter Ctrl+F7

Flow Filter - Work with lines/accounts in 
the same dept., date, project, budget, 
business unit, or any combination

Shift+F7
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Shortcut Keys
Show All Ctrl+A

All fields in a card Ctrl+F8 (Zoom in)

Find contents of a field Ctrl+F (Find)

Limit window to certain contents in field F7 (Field Filter)

Limit window to certain contents in 
multiple fields at one time

Ctrl+F7 (Table Filter)

Search for the next or previous card in the 
database

PgDn or PgUp 

Function Hot Key
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Appendix B: Navision Flowchart
This flowchart shows how data flows through the individual modules within Navision. The 
General Journal (Financial Management Module) only feeds the General Ledger. The Project 
Journal feeds the Project Ledger and General Journal. It is important to understand to where the 
data you enter flows.
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Glossary
Glossary
Active – used to describe the window or button that is 
being used or is selected. Only one window or one 
button can be active at a time. When a window is active, 
the color of the title bar changes to assist you in 
determining which window is active. When a button is 
active, the name changes color.

Application Area – one of the main functional areas of 
the program in which a user selects to work, e.g. 
General Ledger, Inventory, etc.

Application Window – the window in the program on 
which the rest of the work in the program is based. In 
Navision, it is the empty area where all windows are 
opened, and where the program, company and database 
names appear, as well as the menu bar and toolbar.

Arrow Keys – a group of keys on the keyboard used to 
move up, down, to the right and to the left; these keys 
can be used instead of the mouse to move through the 
program.

AssistButton – one of four buttons that are accessed 

using the F6 function key; Drill Down , Look Up 

, Options  and Ellipsis . 

Backup – a file you create which contains a copy of 
your data.

Batch job – a routine that processes selected entries 
according to general or specific guidelines. Examples 
include Close Income Statement.

BLOB – an acronym for Binary Large Object, used to 
store bitmaps such as a logo.

Boolean – a data type that is used to indicate one of two 
values: TRUE or FALSE; a typical use may be in a 
Check Box field. 

Browse – move within a window or from window to 
window on the screen, one way to browse would be to 
use the VCR buttons.

Button – buttons are found in almost all of the windows 
and dialog boxes in the program. They may be Ordinary 
buttons such as OK, Yes and No. They may be Function 
buttons which initiate a function, batch job or report. In 
addition, there are Menu buttons which have a 
downward-pointing triangle on them and they are found 
on the majority of windows. When clicked, they display 
a menu from which you can, for example, select a 
function, open a different window or open a submenu.

Card Windows – a data view which shows information 
about one customer, vendor, item, etc. Card Windows 
generally have a series of tabs at the top. See Tabular 
Window.

Check Boxes – boolean fields that are used to indicate a 
function is turned on when checked and not turned on if 
left blank.

Clear – to clear something means to delete it; it may be 
used for a field or a complete line.

Close – used to exit a window or the program; accessed 
by pressing the Escape key, selecting File, Close or by 
clicking the X button in the upper right hand corner of a 
window.

C/OCX – an interface used to expand the C/Side 
development environment. This may include OLE or 
OCX controls.

C/ODBC – a tool used to export accounting information 
from Navision into other programs that then are used to 
perform graphical analysis and word processing 
functions; Open Database Connectivity.

Codeunit – a function that performs a process, such as 
posting or creating orders. One of five Object types in 
Navision.

Command Button – buttons which initiate a function, 
batch job or report.

C/SIDE – Navision’s development environment.
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Glossary
Database – where all the information in Navision is 
stored; it includes customizations for your company.

Dataport – a method of importing or exporting 
information in and/or out of Navision. One of five 
Object types in Navision.

Debugger – a tool used to diagnose where an error 
message or error is occurring in Navision. Accessed 
under Tools, Debugger.

Designer – the interface used to modify or design 
additional forms, reports, tables, dataports and codeunits 
for Navision. You must purchase special permissions to 
be able to use designer.

Dialog Box – windows that display to obtain more 
information on an action that you want to start. 

Dimension – data that you can add to an entry so that 
Navision can group entries with similar characteristics 
and easily retrieve these groups for analysis purposes. 

Documents – a report that prints one transaction at a 
time. Documents are normally sent outside your 
company to Vendors, Customers or Tax Reporting 
Authorities.

Drill Down  – one of four types of Assist Buttons. 
The downward arrow indicates the value in the field is 
calculated from another table; clicking on the arrow 
allows you to view that table.

Drop-down  – one of four types of Assist Buttons. 
A short, predefined list from which you to select the 
desired choice. 

Ellipsis Button  – one of the four types of Assist 
Buttons. Ellipsis Buttons are used to view system-
filtered options.

Field – used to enter or display information; consists of 
a field name, definition and field contents.

Field Filter – a filter that is set on a single field in a 
table, limiting the amount of information displayed or 
printed.

Filters – a tool that allows you to limit the scope of 
information presented online or in printed format; the 
three filters are Field, Table and Flow.

Flow Filter – a filter which limits the amount of 
information presented based on a value that posted with 
the entries. Flow Filters are set on fields that end with 
the word Filter. 

Focus – where the cursor is placed in Navision, also see 
Insertion Point.

Form – displays information on the screen and gives 
access for editing, deleting and adding data in either a 
card or tabular form. One of five Object types in 
Navision.

Function Keys – each of the function keys has a 
shortcut assigned to it and using the combination of the 
Control or Shift key with a Function key provides 
additional shortcuts. The availability of the various 
shortcuts is screen dependent, this may be reviewed by 
accessing Help, Overview of F Keys (Alt+F1).

Granule – a basic building block of Navision allowing 
firms to purchase only the functionality they need.

HTML – an acronym for hypertext markup language, a 
format widely used on the web.

Inline Editing – used to change the contents of selected 
fields in posted entries; accessed by clicking F2 twice. 

Insertion Point – the spot where text is entered when it 
is typed. Normally appears as a blinking vertical line in 
a window or a dialog box. Also called the cursor 
because the blinking vertical line is one form the cursor 
can take.

Invoice – an original entry document in Purchases & 
Payables and Sales & Receivables allowing information 
to be recorded and posted for purposes of recording 
amounts due to/from Vendors and Customers. Differs 
from Orders in that Receiving and/or Shipping are not 
done from an Invoice.
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Key – a field or combination of fields in a table that may 
be used to sort the table.

Ledger Entries – posted activity linked to a table.

License – a file containing a record of the Navision 
granules purchased by your company; may be viewed 
by selecting Tools, License Information.   

List  – a data view which has multiple records per 
window, displaying information about several 
customers, vendors, items, etc. at one time; another way 
of describing a Tabular Window. Accessed from a Card 
view by selecting the List button from the Tool Bar. See 
also Tabular Window.

Look Up  – one of four types of Assist Buttons. The 
upward arrow indicates this is a way to view another 
table; once viewed, data may be retrieved and inserted 
into the field you accessed the table from.

Master Item – the primary table in a granule, around 
which that granule functions.   Customers are the Master 
Item in Sales & Receivables.

Menu Bar – located just below the Title Bar; this 
standard Windows feature contains pull-down menus to 
select functions such as creating new companies, design 
tools, and help.

Menu Button – have a downward-pointing triangle on 
them and they are found on the majority of windows. 
When clicked, they display a menu from which you can, 
for example, select a function, open a different window 
or open a submenu.

Navigate – a function that allows you to view a 
summary of the number and type of entries related to the 
document. When you select the entry you want in the 
table and click Navigate, you see a list of the records - 
grouped according to table - that have the same 
document number and the same posting date as the entry 
you selected.

Object Designer – the interface used to modify or 
design additional forms, reports, tables, dataports and 
codeunits.

Objects – The building blocks of Navision. There are 
five types of objects – Forms, Tables, Reports, 
Dataports and Codeunits. 

ODBC – an acronym for Open Database Connectivity. 
Enables Navision to be linked and data copied to Excel, 
Crystal Reports, etc.

Option (Radio) Button – a circular field which serves 
to select only one option from those listed. Placing a dot 
in the field indicates the desired choice.

Option List  – one of four types of Assist Buttons. 
A short, predefined list from which you selects the 
desired choice. 

Order – an original entry document in Purchases & 
Payables and Sales & Receivables allowing information 
to be recorded and posted for purposes of recording 
amounts due to/from Vendors and Customers. Differs 
from Invoices in that Receiving and/or Shipping are 
done from an Order.

Passwords – necessary when security has been setup; 
used in combination with you Id to log into Navision. 
Data entry in Navision is case sensitive in the Password 
field.

Primary Key – a field in a table that is used to identify 
the record in the table and is therefore required to have a 
unique value.

Pull-Down Menu – a listing of options available from a 
menu button or menu item.

Purchase Invoice – used to record vendor bills that do 
not have inventory items on them, vouchers would be 
recorded here.

Record – one line of a table, for example a single 
Customer in a listing. A record contains multiple fields 
and a table contains multiple records.

Record Indicator – appears to the left of the record you 
are focused on in a List or Tabular Window.

Recorder Buttons – a series of buttons on the Tool Bar 
that are used to move through a list of records. 
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Reports – a printout of information from the database; 
reports are generally used internally by management. 
One of five Object types in Navision.

Restore – a process whereby you create a database and 
populate it with the information held in your backup 
file. 

Request Form – the form that is displayed prior to 
printing or previewing a report that allows you to set 
filters and select options prior to printing.

Shortcut Key – a keystroke or keystroke combination 
that moves to another screen or function within 
Navision.

Sort – the ability to change the order in which records 
are displayed or printed.

SQL – Structured Query Language.

Status Bar – located at bottom of the application 
window; it shows the name and contents of the active 
field, work date, user ID, and whether a filter (FILTER) 
or insert (INS)/overwrite (OVR) mode is on.

System Date – the date of your computer.

Table – a table consists of a group of related records, 
each record is made up of fields and each field holds one 
piece of information; one example of a table is the entire 
listing of Vendor records. One of five Object types in 
Navision. 

Table Filter – this option enables you to set multiple 
Field Filters on a table, limiting the amount of 
information displayed or printed. 

Tabular Window – a data view that has multiple 
records per window, displaying information about 
several customers, vendors, items, etc. at one time. See 
also Card Window and List.

Text Box – a small box in a dialog box or window; it is 
used for entering information necessary for the 
execution of a command.

Title Bar – located at the top of the screen; displays the 
name of the company you are currently working in and 
the name of program (Microsoft Navision).

Toggle Mark (Ctrl+F1) – a function that allows you 
select certain records for viewing, posting, etc. When 
selected, a diamond appears in front of the Record 
Indicator of the record you are on. If you move off of the 
record, the diamond remains. You may limit your view 
by selecting View, Marked Only.

Tool Bar – located just below the Menu Bar; contains a 
row of iconic buttons to give quick access to frequently 
used functions such as editing, filtering and locating 
data. 

TrendScape Window – a form in Navision that allows 
you to view a summary of data by a time period, such as 
by day, week, month, quarter or year or Accounting 
Period. 

Work Date – the date displayed in the Status Bar; may 
be set by accessing Tools, Work Date. If you do not 
change the Work Date, it defaults to be your system 
date.

Zoom (Ctrl+F8) – allows you to view fields and the 
values for those fields which are not included in the 
current screen display. 

ZUP File – a file in which a user’s specific screen 
modifications are stored, the file is named FIN.ZUP.
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